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1

Introduction

1.1

Contents
This document contains information that you need in order to use your product throughout the
applicable stages of the product life cycle. These can include the following:
■

Product identification

■

Delivery, transport, and storage

■

Mounting and installation

■

Commissioning and operation

■

Maintenance and repair

■

Troubleshooting

■

Dismounting

■

Disposal

Note!
This document does not substitute the instruction manual.
Note!
For full information on the product, refer to the instruction manual and further documentation on
the Internet at www.pepperl-fuchs.com.
The documentation consists of the following parts:
■

Present document

■

Instruction manual

■

Datasheet

Additionally, the following parts may belong to the documentation, if applicable:

1.2

■

EC-type of examination

■

EU declaration of conformity

■

Attestation of conformity

■

Certificates

■

Control drawings

■

Additional documents

Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and
dismounting lies with the plant operator.
Only appropriately trained and qualified personnel may carry out mounting, installation,
commissioning, operation, maintenance, and dismounting of the product. The personnel must
have read and understood the instruction manual and the further documentation.
Prior to using the product make yourself familiar with it. Read the document carefully.

2016-03

1.3

Symbols Used
This document contains symbols for the identification of warning messages and of informative
messages.
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Warning Messages
You will find warning messages, whenever dangers may arise from your actions. It is mandatory
that you observe these warning messages for your personal safety and in order to avoid
property damage.
Depending on the risk level, the warning messages are displayed in descending order as
follows:
Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.
Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.
Caution!
This symbol indicates a possible fault.
Non-observance could interrupt the device and any connected systems and plants, or result in
their complete failure.

Informative Symbols
Note!
This symbol brings important information to your attention.

Action

2016-03

This symbol indicates a paragraph with instructions. You are prompted to perform an action or
a sequence of actions.
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2

Product Specifications

2.1

Application and Use
FDH-1 is a portable fieldbus diagnostic handheld for physical layer testing. The device is
designed for use in intrinsically safe fieldbus systems for FOUNDATION Fieldbus and
PROFIBUS PA according to FISCO, Entity, and DART. The handheld examines segments
during commissioning, maintenance, and troubleshooting.
FDH-1 includes a keypad and a monochrome LCD with a resolution of 128 x 64 pixels. Easy
interaction via keypad and LCD enable you to use the handheld independently of a stationary
PC. FDH-1 can be segment-loop powered, battery-powered, or powered by a USB port. The
supplementary handheld management PC software provides access to all measurement
functions. For documentation purposes, you can upload and store data on the PC. The
software supports multiple languages that you can download onto the handheld.
The following use cases are supported:

Cable Continuity, Grounding, and Insulation Test during Commissioning
FDH-1 checks the integrity of the cable(s) installed before the devices are connected.
See chapter 7.5.6

Segment Checking during Commissioning and Maintenance
After the installation is complete and before the loop check commences, use FDH-1 to check
the physical condition of the segment. A physical layer in good operational condition is the
basis for a successful loop check and plant commissioning. FDH-1 checks the segment with a
minimum of interactions and simple-to-use automated procedures. In case of faults, an expert
system provides information about fault causes and recommendations on how to resolve them.
The results can be stored in the FDH-1.The handheld records comprehensive physical layer
values for a baseline report and suggests which limit values to store.
See chapter 6.6.1

Online Measurement for Quick Check during Operation or
Troubleshooting
General physical layer check: FDH-1 measures all relevant physical layer values and displays
the individual values on its LCD.
Expert system analysis: The analysis helps to detect physical layer values that are out-ofspecification or are maintenance required. As a result, the failure and the potential root cause
are listed. Warnings indicate early on that a fault has occurred or that the quality of the
installation is degrading. Proactive corrective action is possible, preventing unwanted plant
shutdowns.
See chapter 6.2

Integrated Fieldbus Oscilloscope for Analysis
The built-in oscilloscope is a powerful tool used for analyzing the data signal for a specific
telegram type, or a communication error. The oscilloscope analyzes and displays the signal
within a sampled period. An engineer can use the trigger output to analyze the signal with an
external standard oscilloscope in detail. The trigger condition is set by FDH–1.
See chapter 6.4

2016-03

Failure Margin Checking for Commissioning of Installed Components
The failure margin of each installed component on a working segment can be determined:
FDH–1 changes the following parameters to a level where the fieldbus device starts to fail:
signal amplitude, jitter, and noise of the data sent to each individual fieldbus device. This way,
you can determine the upper limits for each device and identify the weaker fieldbus devices in a
fieldbus installation.
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See chapter 6.5.2

Device Coupler Short Circuit Test
Test to validate if the outputs of a device coupler are short-circuit proof. In the course of it, the
load current at a device coupler output is increased until it goes into short-circuit condition. The
peak current value is determined. This value can be checked against the manufacturer’s
specifications.
See chapter 6.6.2

FDH-1 Feature List
■

Automatic generation of a ‘live list’ with identification information of the tag description,
device and manufacturer ID.

■

Cable check function to test a given cable for its usability in fieldbus installations.

■

■

■

2.2

Quick check function to automatically test a segment. The result is shown as a status
message according to NAMUR NE107. An expert system provides fault causes and
recommends a counter action to resolve the problem. In order to increase the accuracy of
the expert system advice, segment conditions such as topology information can be
predefined.
Measurement function to measure all relevant physical layer values, e. g., segment
voltage, unbalance, jitter, noise, minimum signal level, maximum signal level. Values are
displayed either for the segment or for a specific device.
Commissioning wizard to check a segment with simple-to-use automated procedures.
FDH-1 stores records of the results of the segment scan, optionally including oscilloscope
traces. The commissioning data can be downloaded, stored, and printed using FDH-1
Manager.

■

Support of communication statistics for frame count, CRC errors, framing errors, error
rate.

■

Integrated fieldbus oscilloscope with external hardware trigger.

■

Failure margin test to determine the upper failure limit for each individual field device.

■

Device coupler spur test to verify the short circuit current limitation electronics and
measure the maximum short circuit current.

■

Multi-language support.

■

PC program for visualization, measurement report handling, language, and firmware
update.

General Terms and Functions of the Fieldbus Diagnostic Handheld
Each segment monitored by FDH–1 has either of the 2 states:
1. Not Commissioned: This is the initial state of segments. All diagnostics in this state are
based on either of the following:
•
•

Limits defined by the fieldbus standard IEC 61158–2
Limits calculated from information on the segment topology, e.g., trunk cable length
and the type of device couplers used
2. Commissioned: A segment is set to commissioned if an initial checkout was executed to
verify an error-free installation. In the commissioned mode, the segment is validated
against limits defined during the commissioning procedure. These limits can be specified
manually for each segment, but typically the commissioning wizard is used.
This mode is used to commission a segment and guarantee an error-free installation.
For more information on the commissioning wizard on the PC software, see chapter
8.14.2.
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For more information on the commissioning wizard on the handheld, see chapter 7.3.
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The distinction is important if you edit segment record data for future segment checks, see
chapter 8.6
The overall segment and each single diagnostic value is classified by FDH–1 using NE 107
diagnostic information icons.
NE107 diagnostic information icons are displayed both on the handheld and the PC as a result
of all FDH-1 checks that deliver diagnostic information.
Not Commissioned

Diagnostic Information
Excellent: 
All values are within the specification limits with an excellent safety
margin.
Good: The value is within the specification limits but the safety margin
is reduced. Values within IEC 61158-2 limits, but with small safety
margins or values are not matching with expected values of the
topology.
Out of Specification (OoS):
The value exceeds the specification limits. At least 1 value violated an
IEC 61158-2 limit.

Commissioned

Diagnostic Information
No Error:
The value is within the commissioned limits.
Maintenance required (Mreq):
The value is outside the commissioned limits (but still inside the
allowed range). At least 1 value changed since commissioning.
Out of Specification (OoS):
The value exceeds the specification limits. At least 1 value violated an
IEC 61158-2 limit.
Failure:
Field devices that were active on the segment during commissioning
and are not active any more are marked as failure. If a hardware failure
is detected or communication between the handheld and the segment
fails, this is marked as failure.

The Expert System

2016-03

FDH-1 includes a so-called expert system. The expert system relieves you from manually
analyzing all measurement results of the handheld. The expert system automatically analyzes
all measured values and provides detailed diagnostic messages on any issue found on the
segment. The system gives information on the root causes and suggests actions to solve
issues. The expert system takes into account whether the segment is commissioned or not
commissioned and provides optimized messages for the 2 different use cases.
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2.3

Display and Controls
FDH-1 Display and Keypad
2

3

4

1

LC display 128 x 64 dot

2

Keypad with 8 keys

3

Menu status bar displayed. Prerequisite: FDH-1 is switched on and function is selected

4

Menu entry or information field. Prerequisite: FDH-1 is switched on and function is selected

2016-03

1
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FDH-1 Firmware Header Menu

1

1

2

3

4

5

6

Fieldbus type:
■ FF: FOUNDATION Fieldbus, listener mode
■

FF+: FOUNDATION Fieldbus, communication enabled

■

PA: PROFIBUS PA, listener mode

■

PA+: PROFIBUS PA, communication enabled

2

Communication mode:
■ LAS: Displayed in FF mode, LAS mode active

3

Device count:
■ DCNT =x: Displayed in FF or PA mode, "x" is the number of detected devices

4

Type of segment record:
■ SPE: Displayed in FF mode, specific segment record selected

■

Master: Displayed in PA mode, FDH-1 is the only active master

■

CUS: Displayed in FF+ mode, customized segment record selected

■

UNS: Displayed in PA mode, unspecific segment record selected

5

Number of accessible submenus

6

Power modes:
■ BUS: Bus powered
■

USB:

USB powered

■

Battery:
With battery: Dynamic status icon for charging condition

and 


•

With rechargeable battery: Static battery status icon


2016-03

•
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Keypad Overview
You can use the keypad to navigate through the menu and submenus. Dedicated keys perform
a function without the need to navigate through the menu.
Keys


Function description
In order to navigate through a list of menu items, press the Up and Down arrow
keys.
Use the Right arrow key to page through the different views.
The Home/Power key is used to power on and switch off the handheld. If the
handheld is powered, you can use the Home key to jump directly to the main
menu.
The Measurement key launches the online measurement of the physical layer
values and displays the results continuously on the LC display.
The Quick Check key launches the expert system online measurement of the
physical layer values and displays the recapped result on the LC display.
In order to open a selected menu item or launch a dedicated function, use the OK
key.
The Cancel key interrupts the current function and brings you back to the next
higher level in the menu structure.

2.4

Segment Data Records
FDH-1 offers various test functions to validate the physical layer of a segment. The results of
the test can be stored as ‘segment test records’ on FDH–1. Later, you can upload these test
records to a PC using FDH-1 Manager. You can examine the results and store them in a
database. Also, you can generate a report for documentation purposes.
For more information, see chapter 8.
Segment Data Records

1

2

USB

26.8 V
Unbalance 0.0%
Noise 29.0 mV
Jitter 0.8 µs

2

BUS

26.8 V
Unbalance 0.0%
Noise 29.0 mV
Jitter 0.8 µs

14

1

Perform segment test measurements

2

Upload segment test records to the PC

3

Print segment test records

4

Store segment test records in database

4

2016-03
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If needed, you can link different test records to a segment ‘data record’. The data can be used
as a reference for future measurements and comparisons.
3 different kinds of segment ‘data records’ are available:
■

Specific segment data record

■

Customized segment data record

■

Unspecific segment data record

The different types of data records are introduced in the following sections.

Specific Segment Data Record
FDH-1 Manager can generate specific segment ‘data records’ offline. The ‘data record’ can
store detailed information, e. g., segment topology, address, and tag numbers of the devices.
An embedded expert system calculates the expected measured physical layer values and
determines the failure limit values. Once the data record has been downloaded onto FDH–1,
the information is available for the different measurement procedures and as reference. When
the measurements are complete, you can upload the test record to the PC again for
visualization and storage in the database.
For more information, see chapter 8.
Specific Segment Data Records

4
1
USB
Expert System
Software

Bus

2
5
3

6

7

Specific segment data record stored offline

2

Expert system software calculates the expected physical layer values and determines
the failure limits for the offline segment design for each specific segment. Segment design reference values are generated for download to FDH-1.

3

Download segment design reference values from a segment data record

4

Segment test measurements are performed on the segment

5

FDH–1 makes the segment design reference values available for the different test procedures

6

Completed segment test records

7

Upload via USB for visualization and storage to the database

2016-03

1
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Customized Segment Data Record
If no detailed information for each individual segment is available, the customized data record is
used. In this case, the segment with the most demanding topology is used as a reference,
against which all other segments are tested.
The customized segment data record must contain information on the power supply, cable type
and length, and the device coupler type.
Once the data record has been downloaded onto FDH–1, the information is available for the
different measurement procedures and as reference. Only one customized segment data
record is available in FDH–1 Manager as well as on FDH–1.
For comparison,

see image on page 15.

Unspecific Segment Data Record
The unspecific segment data record does not contain any detailed information on the segment.
The unspecific data record is used for visualization and storage of different online tests. The
same applies if FDH-1 is connected to a PC via the USB interface. The test results are then
stored in an unspecific segment data record on the PC.
Unspecific Segment Data Records

1

4
BUS

3
2

26.8 V
Unbalance 0.0%
Noise 29.0 mV
Jitter 0.8 µs

1

2

1

2

3

3

2.5

1

Perform segment test measurements

2

Generate segment test records

3

Upload record for visualization and storage to the database

4

View test records online and store to database.

Memory Management
FDH-1 features 2 different memory areas:
■

Segment data record memory

■

Segment test record memory

Segment data records contain all segment-specific information. The information is required to
commission, maintain, and troubleshoot a segment of a fieldbus topology and the connected
field devices. The segment data record memory can store data records for up to 32 segments
with 32 field devices each.

16
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Segment Test Record Memory
The handheld can store results of online measurements in its test record memory. Results
include:
■

Commissioning records

■

Check segment records

■

Segment failure margin test records

■

History records

■

1 oscilloscope trace

The number of test records that can be stored in FDH-1 depends on the number of devices
connected to a segment. The following numbers are valid if only one type of test record is
stored. FDH-1 calculates the available memory by taking the real size of the test record into
account. Therefore, more test data records can be stored depending on the types of test
records stored and the number of connected devices.
■

For commissioning or segment check data without oscilloscope traces:

•  20 devices per segment: 24 data records
•  20 devices per segment: 12 data records
■ For commissioning or segment check data including oscilloscope traces for each device:
•  4 devices per segment: 6 test records
•  8 devices per segment: 4 test records
•  12 … 18 devices per segment: 2 test records
•  19 … 32 devices per segment: 1 test record
■ For failure margin tests:
•  20 devices per segment: 12 test records
•  20 devices per segment: 8 test records
■ For history data: 72 history samples
■

For oscilloscope data: One entire telegram can be stored

The oscilloscope traces included in the records contain pictures of the preamble, start of frame,
one data bit and end of frame.
This takes the full test record memory. Beside an entire telegram oscilloscope trace, no
additional test records can be stored. Stored test records can be deleted from FDH-1.
For more information, see chapter 7.6.1.

2.6

Language Support

2016-03

The default language of FDH-1 is English. Multiple languages are available for download via
FDH–1 Manager Premium software. Check the datasheet for available languages.
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2.7

FDH-1 Technical Data
Supply
Connection

Fieldbus , Battery , 9V 6LR61 block, type alkaline, carbon-zinc,
lithium iron disulfide, nickel-cadmium, nickel-metal hydride, or
rechargeable lithium , USB

Fieldbus interface
Fieldbus type

FOUNDATION Fieldbus/PROFIBUS PA

Rated voltage

8.5 ... 35 V

Rated current

... 10 mA , if bus powered

Indicators/operating means
Display

LC display

Keypad

Membrane 8 keys

Directive conformity
Electromagnetic
compatibility
Directive
2004/108/EC

EN 61326-1:2013

Software
Languages

English (default), German (optional), Portuguese (optional),

Standard conformity
Electromagnetic
compatibility

NE 21:2011

Degree of protection

IEC 60529

Shock resistance

EN 60068-2-27

Vibration resistance

EN 60068-2-6

Ambient conditions
Ambient temperature

-20 ... 50 °C (-4 ... 122 °F)

Storage temperature

-20 ... 70 °C (-4 ... 158 °F)

Relative humidity

< 95 % non-condensing

Shock resistance

15 g , 11 ms

Vibration resistance

1 g , 10 ... 150 Hz

Mechanical specifications
Connection type

Fieldbus: Cable with test clips and cable with test plugs, 2.5 mm 
Trigger output: Cable with 2 banana plugs 
USB: Square type B socket

Degree of protection

IP44

Mass

500 g

Data for application in connection with Ex-areas

Group, category, type
of protection,
temperature class

Bus

18

II 2(1) G Ex ib [ia Ga] IIC T4 Gb ,
II 3(1) G Ex ic [ia Ga] IIC T4 Gc ,
II 3 G Ex ic IIC T4 Gc ,
II (1 D) [Ex ia IIIC Da] ,
II (3 D) [Ex ic IIIC Dc]

2016-03

EC-Type Examination ZELM 14 ATEX 0531
Certificate
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Type

Fieldbus

Type of protection

ia, ib

Internal capacitance

< 1.8 nF

Internal inductance

< 1.5 µH

Voltage Ui

30 V

Bus
Type

Fieldbus

Type of protection

ic

Internal capacitance

< 1.8 F

Internal inductance

< 1.5 µH

Voltage Ui

35 V

Outputs
Type

Trigger output

Maximum safe voltage 140 V
Interface
Type

USB interface

Maximum safe voltage 253 V
Voltage Ui

6V

Directive conformity
Directive 94/9/EC

EN 60079-0:2012 , EN 60079-11:2012

International approvals
CSA approval

CSA 16.70029275

IECEx approval

IECEx ZLM 14.0012

Approved for

Ex ib [ia Ga] IIC T4 Gb ,
Ex ic [ia Ga] IIC T4 Gc ,
Ex ic IIC T4 Gc ,
[Ex ia IIIC Da] ,
[Ex ic IIIC Dc]

General information
Statement of Conformity, Declaration of Conformity, Attestation of
Conformity and instructions have to be observed where applicable.
For information see www.pepperl-fuchs.com.

2016-03

Supplementary
information
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2.8

Dimensional Drawings
40.7

135

138.3

197

2016-03

All dimensions are in millimeters and without tolerance indication.
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2.9

Scope of Delivery
FDH-1 is delivered in a transport case.
The following items are included in the scope of delivery:
Fieldbus Cordset with 3-Pin Test Plugs

Figure 2.1

■

FDH–1, included in delivery: ACC-FDH-CBUSC fieldbus cordset with 3-pin test plugs
for use with Pepperl+Fuchs fieldbus infrastructure products, e. g., power supplies and
device couplers

Cable length: 2 m
Brown cable: Bus+
Black cable: BusBlue cable: Cable shield/screen

2016-03

•
•
•
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Fieldbus Cordset with 3 Test Clips

Figure 2.2
■

FDH–1, included in delivery: ACC-FDH-CBUSP fieldbus cordset with 3 test clips

Cable length: 2 m
•
•
•

Red test clip: Bus+
Black test clip: BusBlue test clip: Cable shield/screen

USB Cable
Cable for connecting the handheld with the PC.
Cable length: 1.8 m

2016-03

■
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Accessories
The following accessories are available for purchase:
Trigger Output Cable with 2 Banana Plugs

Figure 2.3
■

FDH–1 accessory: Trigger output cable with 2 banana plugs

Cable length: 2 m

• Red cable plug: Bus+
• Black cable plug: Bus■ Order code: ACC-FDH-CTRG

PC Premium Software
Additional accessory is FDH–1 Manager Premium software.

Features
Fieldbus
oscilloscope

Visual tool for the fieldbus expert to
display the signal waveform and
support for finding tricky faults

Premium
Basic Edition Edition 
(Accessory)
(included)
X

Additional trigger functionality for
external oscilloscope

2016-03

Documentation
and comparison

Configuration

Upload of commissioning records for
backup, storage, and documentation

X
X

X

X

Upload and comparison of history
recordings with online measurements

X

Download of specific and customized
data records for comparison

X

Multi-language support

X
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3

Installation and Commissioning

3.1

FDH-1 Modes of Operation
The FDH-1 supports different modes of operation.
Fieldbus powered: FDH–1 is powered by the segment it is connected to. The handheld is
operated using the keypad and the LC display.
Battery powered: FDH–1 is powered by an optional battery. The handheld is operated using
the keypad and the LC display.
USB powered without using FDH–1 Manager: FDH–1 is powered by the USB interface it is
connected to. The handheld is operated using the keypad and the LC display.
USB powered using FDH–1 Manager: FDH–1 is powered by the USB interface it is
connected to. The handheld is operated using FDH–1 Manager software. The keypad and the
LC display on FDH–1 are disabled.

3.2

Powering the Handheld
Danger!
Explosion hazard from wrong powering mode in hazardous areas
Using the device in a powering mode in a hazardous area that it is not approved for can cause
sparks that can ignite the surrounding potentially explosive atmosphere.
Ensure that the the powering mode you intend to use matches the hazardous area usage. For
details, see chapter 3.4.
FDH-1 supports 3 different power modes:
■

Fieldbus powered

■

Battery powered

■

USB powered

Fieldbus-Powered Mode
FDH–1 can be powered by the segment of the fieldbus. In this case, the handheld uses a
maximum current of 10 mA.

Battery-Powered Mode
FDH-1 can be powered by a 9 V 6LR61 battery.
If non-rechargeable batteries are used, the handheld indicates the charging condition on the
LCD.
Caution!
Property damage from leaking batteries
Leaking battery acid may cause personal injury and damage to the device.
■

Never use batteries that are leaking.

■

Never use batteries with external damages, even if no battery acid is leaking.

■

Check the battery compartment for leaking battery acid at regular time intervals.

Using the wrong type of battery may cause damage to the device.
When replacing the battery, use batteries of the correct type only.
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The following battery types can be used with the device according to IEC 6F22:
■

Alkaline

■

Zinc carbon

■

Lithium iron disulfide

■

Nickel-cadmium

■

Nickel-metal hydride

■

Lithium nine-volt

For information on battery powering in hazardous gas atmospheres, see chapter 3.4 .

USB-Powered Mode
FDH-1 supports a USB 2.0, type B, interface to connect the handheld to a PC. In this case, the
handheld is powered by the USB port. Use the USB cable included in the delivery.
For information on USB powering in hazardous gas atmospheres, see chapter 3.4.

Power Mode Priorities
The power modes of FDH–1 by default are set to be used in the following priority, from high to
low:
1. USB
2. Battery
3. Fieldbus
When powering FDH–1 with a battery, switch on the handheld first, before connecting it to a
segment.

3.3

Battery Handling
Exchanging the Battery
The battery is changed as follows:

2016-03

1. Open the cover of the battery compartment.

2. If applicable: Take out the old battery.

25

Fieldbus Diagnostic Handheld
Installation and Commissioning

3. Insert a new battery.

For details on the type of battery see chapter 3.2

2016-03

4. Close the cover of the battery compartment and tighten the screws.
Required torque: 0.7-0.8 Nm 
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3.4

FDH-1 Hazardous Area Usage
In this section you find the possible options and restrictions for using FDH–1 in hazardous
areas.
Danger!
Explosion hazard from battery usage or powering in hazardous areas
The presence of a functional battery in the device in hazardous areas may lead to currents or
voltages that may cause sparks. These sparks can ignite the surrounding potentially explosive
atmosphere.
Do not take the device into hazardous areas with the battery inserted.
Danger!
Explosion hazard from live wiring the USB connection in Zone 1
If you use, connect, or disconnect an USB connection to an energized circuit in a Zone 1
explosion hazardous area, this can cause sparks. These sparks can ignite the surrounding
potentially explosive atmosphere.
Never use the USB connection in Zone 1 hazardous areas.
Danger!
Explosion hazard from live wiring the USB connection in Zone 2 at insufficient type of
protection
If you connect or disconnect the USB connection in a Zone 2 explosion hazardous area to a
circuit with an insufficient type of protection, this can cause sparks. These sparks can ignite the
surrounding potentially explosive atmosphere.
Only connect or disconnect the USB connection to an Ex ic intrinsically safe circuit, e.g., a PC
that is rated Ex ic.
Danger!
Explosion hazard from mixing general and intrinsically safe circuits
Connecting USB and trigger connections in parallel to devices with different types of circuits
can invalidate the intrinsically safe circuit. The circuit can carry excess current or voltage that
causes sparks. These sparks can ignite the surrounding potentially explosive atmosphere.
Ensure that connected devices are both either intrinsically safe or non-intrinsically safe, and
use the connections in the approved areas only.
Danger!
Explosion hazard from loss of intrinsic safety
Failing to verify the intrinsic safety for all circuits that are combined to form an intrinsically safe
system according to IEC 60079–14 can invalidate the type of protection. Excess voltage or
current can cause sparks that can ignite the surrounding potentially explosive atmosphere.

2016-03

Ensure you adhere to IEC 60079–14 for verification of intrinsic safety. If the system is built
according to FISCO, the verification of intrinsic safety is given.
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Danger!
Explosion hazard from insufficient precautions with DART installations
When carrying out work on a DART trunk without hot work permit, energized circuits can cause
sparks that can ignite the surrounding potentially explosive atmosphere.
Only carry out works on a DART trunk in the absence of a surrounding potentially explosive
atmosphere. Ensure you have a hot work permit.
Danger!
Explosion hazard from electrostatic charge, e.g., caused by transport case
Electrostatic charges can discharge and consequently ignite a surrounding potentially
explosive atmosphere while installing or operating the device.
Avoid electrostatic charges during installation and operation of the device. Do not take the
transport case supplied with the device in explosion hazardous areas.
Danger!
Explosion hazard from wrong separation distances
If you do not observe the minimum separation distances between intrinsically safe circuits of
associated apparatus and non-intrinsically safe circuits, this can lead to added currents or
voltages. This can result in a current/voltage flashover generating sparks. The sparks can ignite
the surrounding potentially explosive atmosphere.
Ensure you observe the compliance of the separation distances to all non–intrinsically safe
circuits according to IEC/EN 60079–14.
Danger!
Explosion hazard from insufficient insulation
Insufficient dielectric strength of insulators between intrinsically safe circuits may lead to
interferences and to charge transfers that cause sparks. These sparks can ignite a potentially
explosive atmosphere.
Ensure that the dielectric strength of the insulation between intrinsically safe circuits is at least
500 V according to IEC/EN 60079–14.
Danger!
Explosion hazard from loss of intrinsic safety on the fieldbus connection side
When using a device-to-fieldbus connection in an Ex ia or Ex ib circuit that previously has been
operated with an Ex ic circuit with a voltage U0 that exceeded the voltage Ui specified for type
of protection Ex ia or Ex ib, premature wear can cause sparks that can ignite the surrounding
potentially explosive atmosphere.
Do not operate the device-to-fieldbus connection with Ex ia or Ex ib circuits if the connection
has been operated with an Ex ic circuit with a voltage U0 that exceeded the voltage Ui specified
for type of protection Ex ia or Ex ib.
Danger!
Explosion hazard from damaged intrinsically safe circuits on the fieldbus connection side

Never install the fieldbus connection side that has already been operated in general electrical
installations in electrical installations used in combination with hazardous areas!
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Premature wear of intrinsically safe circuits on the fieldbus connection side that were previously
used in a general electrical installation can cause sparks that can ignite the surrounding
potentially explosive atmosphere.
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FDH-1 Use in Zone 1

Trig.

USB

Bus

FDH-1

Safe Area

1

Zone 1
Gas Group IIC, T4

Zone 0

Bus port
FDH–1 power options:
■ Zone 0 (ia) input for bus powering
■

Only with a hot work permit: 9 V battery powering

■

Only with a hot work permit: USB powering

Trigger and USB ports
WARNING: Use these ports only with a hot work permit! 
Maximum supply safety input voltage Um = 253 VAC.
If not used, connectors can be left open.

3

Any fieldbus terminal access point
WARNING: Connect FDH–1 to non-intrinsically safe equipment or circuits only with a hot
work permit.
All intrinsically safe circuits must be in accordance with Entity, FISCO, or DART. Depending on the type of protection required, observe the following maximum input voltages:
■ Ex ia or ib: Ui = 30 V

2016-03

2
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FDH-1 Use in Zone 2

Trig.

USB

Bus

FDH-1
Trig.

CH 1

SafeSafe
AreaArea

1

Zone 2
1
SafeIIC,
Area
Gas Group
T4

Zone 0

Bus port
FDH–1 power options:
■ Zone 0 (ia) input for bus powering
■

Only with hot work permit: 9 V battery powering

■

USB powering

2

USB connection between PC and FDH–1
Only connect a peripheral with the following specification to this USB port: 
Maximum supply safety input voltage Um = 253 VAC.
PC with a USB port certified Ex ic or better.

3

Trigger connection between external oscilloscope and FDH–1
Only connect a peripheral with the following specification to this trigger port: 
Maximum supply safety input voltage Um = 140VAC.

4

Connection of other equipment to external oscilloscope 
ATTENTION: The oscilloscope used must meet all Entity parameters. For the approvals
on connecting the device to an intrinsically safe bus in the required Zone, contact the oscilloscope manufacturer.

5

Any fieldbus terminal access point
WARNING: Connect FDH–1 to non-intrinsically safe equipment or circuits only with a hot
work permit.
All intrinsically safe circuits must be in accordance with Entity, FISCO, or DART. Depending on the type of protection required, observe the following maximum input voltages:
■ Ex ia or ib: Ui = 30 V
For Ex ic: Ui = 35 V
2016-03

■
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FDH-1 Use in the Non-Explosion Hazardous Area

Trig.

USB

Bus

FDH-1
Trig.

CH 1

Safe Area

1

Zone 1
SafeIIC,
Area
Gas Group
T4

Zone 0

Bus port
FDH–1 power options:
■ Zone 0 (ia) input for bus powering
■

9 V battery powering

■

USB powering

2

USB connection between PC and FDH–1
Maximum supply safety input voltage Um = 253 VAC.

3

Trigger connection between external oscilloscope and FDH–1

4

Connection of other equipment to external oscilloscope 
ATTENTION: The oscilloscope used must meet all Entity parameters. For the approvals
on connecting the device to an intrinsically safe bus in the required Zone, contact the oscilloscope manufacturer.

5

Any fieldbus terminal access point
WARNING: Connect FDH–1 to intrinsically safe equipment or circuits only if the following
requirements are met:
All intrinsically safe circuits must be in accordance with Entity, FISCO, or DART. Depending on the type of protection required, observe the following maximum input voltages:
■ Ex ia or ib: Ui = 30 V
For Ex ic: Ui = 35 V

2016-03

■
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3.5

Connecting FDH-1 to a Segment
Included in the delivery of FDH-1 are 2 cordsets that connect FDH-1 to a segment:
■

■

Fieldbus cordset for use with Pepperl+Fuchs fieldbus infrastructure product: ACC-FDHCBUSC
For more information,
see Figure 2.2 on page 22.
Fieldbus cordset, with 3 test clips: ACC-FDH-CBUSP
For more information,
see Figure 2.1 on page 21.

Design of ACC-FDH-CBUSC
1

2

1

3 combined test plugs

2

Metal part

3

Single modular test plug

4

Fieldbus plug socket

5

Test plug sockets

3

4

5

Connecting ACC-FDH-CBUSC to Fieldbus

Figure 3.1

3.6

Assembly of the test plugs and the fieldbus plug socket

Measuring at the Spurs of Short-Circuit Proof Device Couplers

When using device couplers with short circuit current limitation, electronic or intrinsically safe
current limitation between the trunk and the field devices add more impedance to the fieldbus
network. Thus, seen from the transmission circuit of a fieldbus device, the impedance is much
higher than the anticipated transmission levels seen at a 50 ohm trunk. Depending on the
impedance added by the device coupler, the measured transmission signal levels can be up to
2.5 V.
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The fieldbus specification IEC 61158-2 defines the transmission signal level of the
communicating device between 0.75 Vpp … 1 Vpp at a 50 ohm segment.
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The FDH-1 / FDH-1 Manager expert system has a built-in algorithm to detect device couplers
in a segment. Therefore, even if FDH–1 measures higher transmission amplitudes, the overall
quality statement of the expert system may be excellent.

3.7

Software Installation

3.7.1

FDH–1 Manager
For information on the requirements concerning the operating system and the hardware, refer
to the release notes of FDH–1 available at www.pepperl-fuchs.com.

2016-03

For information on the installation of the PC software, see chapter 8.1.
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4

Switching Device On
The startup behavior differs, depending on the power mode chosen:

Switching the Device On in the Fieldbus Power Mode
1. Connect FDH-1 to a segment. The handheld starts automatically. The startup screen displays a warning information:

WARNING! If FDH–1 is connected to a spur of a device coupler: Ensure that an additional
10 mA current required for FDH–1 does not activate the spur short circuit current limitation
of the device coupler. This can be the case if the spur is already loaded by a connected device. Confirm to increase the current demand of FDH–1 to 10 mA.

2. In order to confirm, press the OK key. The startup screen appears on the LC display:

3. In order to see the safety instructions, press the Right arrow key.
4. Before using FDH-1: Read the safety instructions carefully. Use any function key to
continue.
Quick Check key: One-click test of the physical layer based on the built-in
expert system.
Measurement key: Test of the physical layer with detailed physical layer
information.

2016-03

Home ON/OFF key: Main menu of FDH-1.
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Switching the Device On in the Battery Power Mode
Before using FDH-1: Read the safety instructions carefully. Insert a battery. See chapter 3.3.
1. Press Home ON/OFF key for at least 2 seconds. The startup screen appears.

2. In order to view the safety instructions, press Right arrow key.
3. Before using FDH-1: Read the safety instructions carefully. Use any function key to
continue.
Quick Check key: One-click test of the physical layer based on the built-in
expert system.
Measurement key: Test of the physical layer with detailed physical layer
information.

2016-03

Home ON/OFF key: Main menu of FDH-1.
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5

Switching Device Off
In order to switch off FDH–1, press the Home ON/OFF key for 2 seconds.
Tip
Customizing the auto switch-off time
The handheld includes an auto switch-off time function for use with battery.

2016-03

In order to customize the auto switch-off time, use the Settings > Auto-Off menu function.
Select 5, 10, or 15 minutes, or disable the auto switch-off function altogether.
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6

FDH–1 Firmware Use Cases
The following chapter gives an overview of the most frequent situations in which to use the
diagnostic handheld.

6.1

Segment Record Selection as Reference for Tests and Measurements
As a reference for different test procedures select a segment record from the select segment
record menu.
For detailed information on segment records, see chapter 7.2.

Selecting a Segment Record
1. View a list of stored segment records: Press the OK key.
2. Navigate through the segment records list: Use the Up and Down arrow keys.
3. Select a segment record: press the OK key.

6.2

Quick Check Function
For quick segment testing with no detailed knowledge of the segment use the quick check
function. The condition of the segment is described with the following NAMUR NE 107 status
messages: “Excellent”, “Good”, “Maintenance required”, and “Out of Specification”.
In order to perform a quick check, it is necessary to select a segment record first. The selected
segment record serves as a basis of the quick check and the resulting validation of the
segment health. For detailed information on the different types of segment records, see chapter
2.4.
If faults are detected, the built-in expert system lists the faults, giving a cause and suggesting a
fault solution. As long as the quick check function is active, measurements are continuously
running in the background.

2016-03

If the segment has already been commissioned, the segment record type selected is
"unspecific segment": The evaluation of the measured physical layer values is checked against
the limit values derived from the fieldbus standard IEC 61158-2 or empirical test data.
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Launching the Quick Check Function
Prerequisite: The fieldbus type is selected. See chapter 7.6.2.
1. Press the Quick Check key.

The startup screen shows the actual summary status with the number of messages
generated by the expert system.
Number of “active” messages: Number of persistent faults detected. 
Number of “inactive” messages: Number of intermittent faults detected.
2. In order to see message details, press the Right arrow key.

The message screen shows fault indications. Pressing the Down arrow key provides
possible causes for the fault and suggests resolutions.
3. In order to switch to the next message detailed view, press the Right arrow key.

4. In order to delete all inactive messages, press the OK key.
5. In order to accept the deletion of the message, press the OK key again.

2016-03

6. In order to navigate all back to the start menu screen, repeatedly press the Right arrow key
or press the Cancel key.
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6.3

Measurement
For collecting device-specific detailed information on the segment and the measured physical
layer values use the measurement function. With the measurement function the following
information can be collected:
■

Values measured throughout the overall segment

■

List of detected devices

■

Physical layer values and device-specific information, e. g.: Address, tag description,
manufacturer ID, layer-2 statistics (communication must be activated)

■

Global and device-specific device coupler information if supported by the device coupler:
Maintenance required and out-of-specification alarms

■

Communication statistics

In order to perform a measurement, it is necessary to select a segment record first. The
selected segment record serves as a basis of the measurement and the resulting validation of
the segment health. For detailed information on the different types of segment records, see
chapter 2.4.
As long the measurement function is active, the measurements are continuously executed in
the background. The measured physical layer values are evaluated against either of the
following values:
■

Limit values derived from the fieldbus standard IEC 61158–2

■

Empirical test data

■

Values generated with FDH-1 Manager

■

Values generated during commissioning

The handheld measurement function continuously displays the most important physical layer
values along with the status generated by the expert system.

Launching the Measurement Function
Prerequisite: The segment record is selected. See chapter 7.2
1. Press the Measurement key.

The segment values are displayed.

2016-03

2. In order to switch to the next menu screen, press the Right arrow key.
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The detected devices are listed along with their tag description, the status, and the signal
level issued by the expert system.
3. In order to navigate between the devices, use the Up and Down arrow keys.
4. In order view more details on a specific device, press the OK key.

The information of a specific device is listed, and where appropriate, the status
information issued by the expert system is shown.
5. In order to switch to the next device, press the Right arrow key.
6. Pressing the Cancel key brings you back to the device list.
7. In order to switch to the device coupler diagnostic alarm screen, press the Right arrow key.
If the installed device couplers support physical layer diagnostics, the alarm condition of the
device couplers and the connected devices are listed. For further information refer to the
device coupler manual.

Coupler MReq: Number of devices with an active "maintenance required" alarm.
Coupler OOS: Number of devices with an active "out-of-specification" alarm.

2016-03

Each detected device is listed with its address, tag description, and coupler status.
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8. In order to switch to the communication statistics screen, press the Right arrow key:
Frames: Number of detected frames. 
CRC: Number of detected frames with a cyclic redundancy check (CRC) error. 
Framing: Number of detected frames with a framing error. 
Rate: Error rate taking all detected errors into account in percent (%).
9. In order to switch to the segment record information, press the Right arrow key.
10.The segment record is displayed that was taken as a reference for the physical layer
assessment.
11.In order to switch to the start screen of the measurement function, press the Right arrow
key.

6.4

Fieldbus Oscilloscope
The built-in fieldbus oscilloscope is an advanced visualization and analysis tool for fieldbus
specialists with expert knowledge on fieldbus physics and communication data telegrams. The
oscilloscope visualizes the device signal form and analyzes the telegram content.
Various trigger conditions can be used to capture telegrams where fault conditions are
detected or are likely located.
Recorded signal traces can be uploaded onto a PC for visualization. Even more advanced
trigger settings and detailed visualization of the signal traces are possible. FDH–1 Manager
enables the expert to use the dedicated frontend in combination with the handheld.
For more information on the oscilloscope function of FDH–1 firmware, see chapter 7.5.1.
For more information on the oscilloscope function of FDH–1 Manager, see chapter 8.13.

Launching the Fieldbus Oscilloscope Function
In the FDH-1 home menu, select Advanced tests > Oscilloscope.
Choose the function needed.

6.5

Commissioning
Various extra tools enable you to determine and document the quality of a fieldbus installation
during the commissioning phase.

6.5.1

Segment Commissioning
The commission segment function is a wizard-based tool for an initial assessment of a fieldbus
installation. The functions guide the user step by step through a complete segment checkout.
This initial assessment procedure can be saved and retrieved for a future checkout
comparison. The detection of any deviation from the initial assessment provides a possible
early warning of any potential segment failure.
Depending on the requirements, several different approaches to commissioning can be
performed.

Commissioning without Offline Generated Segment Record
Prerequisite: Before starting the commissioning wizard, the unspecific record is selected.
This function is used when no detailed information on the segment (topology, cable type, etc.)
is available. The limit values used to assess the segment are based on the values derived from
the fieldbus standard IEC 61158–2 and from empirical data. The commissioning results are first
stored in a commissioning test record and linked to the unspecific segment record. Once the
commissioning is complete, the commissioning record can be uploaded to FDH–1 Manager on
the PC and stored in the database. A report can be generated and printed.

2016-03

For details on the commissioning run see chapter 7.3
For details on handling the segment records and test records see chapter 7.2
For details on uploading the test records onto the PC, see chapter 8.5.
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Commissioning with an Offline Generated Segment Record
Prerequisites: Before starting the commissioning, an offline generated segment record is
downloaded onto FDH–1.
If detailed information on a segment is available, a segment record can be generated offline
and stored to FDH–1 Manager on the PC. This information can be: power supply type, device
coupler type, cable type and length, etc. The commissioning results are first stored in a
commissioning test record and linked to the offline generated segment record. Once the
commissioning is complete, the commissioning record can be uploaded to FDH–1 Manager on
the PC. There, the record can be automatically stored in the segment record that was defined
offline. A report can then be generated and printed.
For details on the commissioning run see chapter 7.3
For details on handling the segment records and test records see chapter 7.2
For details on uploading the test records onto the PC, see chapter 8.5.

Launching the Commission Segment Function
In the FDH-1 home menu, select Commission segment.
For more information on commissioning, see chapter 7.3.

6.5.2

Test Failure Margin
The failure margin of each device on a working segment can be determined: FDH–1 changes
the signal amplitude, jitter, and noise levels of the data sent to each fieldbus device to a level
where the fieldbus device starts to fail. The objective is to determine the upper limits for each
device. Thus, you can identify the weaker fieldbus devices in a fieldbus installation. Only
fieldbus specialists who are able to interpret the results correctly should perform this test.

Launching the Test Failure Margin Function
In the FDH-1 home menu, select Advanced tests > Test failure margin. Choose the function
needed.
For more information on testing the failure margin with the handheld, see chapter 7.5.3
For details on uploading the test records onto the PC, see chapter 8.5.
For details on launching the test from the PC, see "Testing the Failure Margin of a Segment" on
page 120.

6.5.3

Wiring Check
Prerequisites: A fieldbus power supply is connected and powered.
The trunk is terminated by 2 terminators, 1 at each end of the cable. 2 FDH–1 devices are
connected to the trunk, 1 at each end of the cable. The wiring check is used to test an existing
cable for its performance in a fieldbus installation. Configure the first FDH–1 to run in the
“Wiring check master” mode. Configure the second FDH–1 to run in the “Wiring check slave”
mode. The result of the test is shown on the LC display of the FDH–1 running in the master
mode.

Launching the Wiring Check Master Slave Functions
In the first FDH-1 home menu, select Advanced tests > Wiring check master. In the FDH-1
home menu, select Advanced tests > Wiring check slave.

2016-03

For more information on launching the wiring check, see chapter 7.5.6.
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6.6

Maintenance Functions
In case of problems, different test procedures can be used to diagnose a segment that is
operational. Alternatively, the segment can be tested during normal scheduled maintenance. If
the result of the checkout does not need to be documented, procedures described in the
chapter “Segment Troubleshooting” can be used if problems occur.

6.6.1

Check Segment
The Check Segment wizard validates a segment against failure and maintenance limits. The
result is stored in a check segment record. This record can be uploaded with FDH-1 Manager
to a PC for documentation and comparison against previous check segment results.
Depending on how you want to manage the physical layer testing, 3 different approaches are
available:
1. Specific segment record: Use FDH–1 Manager to check specific segments based on
commissioning data:
Each segment has specific warning and out-of-specification limit values that can be used for
the segment check. These values are identified during a commissioning run and saved as a
specific segment record.
In order to perform a segment check, download the specific segment record onto FDH–1. The
expert system analyses the data based on the limit values stored in the segment record. In
case of problems, the expert system lists possible causes and suggests possible resolutions.
After the segment check the results are uploaded onto the PC, and automatically linked to the
segment record. Comparison to previous check segment results can be undertaken or check
segment report can be generated.
2. Unspecific segment record: Check segments without segment-specific
commissioning data:
The limit values used for the segment check are derived from the fieldbus standard
IEC 61158–2. Select the ‘unspecific segment record’ during the check segment run. After the
check segment run, the check segment test record can be uploaded to FDH–1 Manager, and
linked to a specific segment record. Comparison to previous check segment results can be
undertaken or a check segment record can be generated.
3. Customized segment record: Check all segments against an individual set of limit
values:
If you do not intend to commission each segment individually, you can generate a “customized
segment record”. This record has a common set of reference data and adjustable failure limits
that is used for the validation of all segments.
A common “typical” set of reference data and failure limits is based on the worst case segment
data, e. g., with the maximum cable length. By default, the FDH-1 memory contains one set of
customized limit values. The limit values can be adjusted with FDH–1 Manager.
During the check segment run, select the customized segment record. Following the check
segment run, the check segment test record can be uploaded to the PC. If available, the
records can be manually linked to a specific segment record. Comparison to previous check
segment results can be undertaken or a check segment record can be generated.

Launching the Check Segment Functions
In the FDH-1 home menu, select Check segment.
For details on the check segment wizard see chapter 7.4

2016-03

For details on handling the segment records and test records see chapter 7.2
For details on launching the check segment wizard with FDH–1 Manager, see "Checking a
Segment" on page 116.
For details on uploading the test records onto the PC, see chapter 8.5.
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6.6.2

Coupler Spur Protection Test
For device couplers with spur short circuit current limitation electronics, FDH-1 supports a
specific test procedure. This procedure is used to verify the operation of each spur short circuit
current limitation circuit and the short circuit current limitation value.
FDH–1 increases the current demand to a maximum current of 60 mA. If the short circuit
current limitation operates correctly, the device coupler isolates the spur output at a current
below 60 mA. FDH–1 shows the maximum current it used before the device coupler isolated
the spur output.
If a spur is tested while a device is connected, the handheld displays the additional current
taken by the handheld itself.

Launching the Test Spur Protection Function

2016-03

In the FDH-1 home menu, select Advanced tests > Test spur protection.
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7

FDH–1 Firmware Menu Description

7.1

FDH–1 Firmware Menu Structure
Select segment record
Unspecific segment record
Customized segment record
Specific segment record

Commission segment
Check segment
Unspecific segment record
Customized segment record
Specific segment record

Advanced tests
Oscilloscope
Trigger on device
Trigger on error
CRC error
Framing error
Maintenance required
Out of specification
Advanced trigger
Multiple trigger conditions depending
on fieldbus type

Test failure margin
Manual mode
Automatic mode
Automatic + Noise

Test spur protection
History recording
Unspecific segment record
Customized segment record
Specific segment record

Wiring check
Wiring check master
Wiring check slave

Settings
Test record memory
Fieldbus communication
Fieldbus type
FDH-1 settings

About

Marks software wizards that,
when selected, automatically
complete a task, e.g., a
measurement or a test.

2016-03

Device tag description
Serial number
Firmware description
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7.2

Segment Record Selection
Test procedures use offline generated limit values stored in the segment record to test against.
Once the measurements are complete, the test records can be uploaded to the PC for
visualization and storage in segment records. In order to select segment records as reference
for different test procedures, go to the Select segment record menu.
For information on uploading test records, see chapter 8.5.

Selecting a Segment Record
1. View a list of stored segment records: Press the OK key.
2. Navigate through the segment records list: Use the Up and Down arrow keys.
3. Select a segment record: press the OK key.

Types of Segment Records
■

Unspecific segment record: Used if no segment records with specific segment
topology and physical layer limit values are available. The limit values are derived from the
fieldbus standard IEC 61158–2. If selected:
•
•

■

Generated test records are linked to “unspecific segment record”
When uploaded onto the PC, generated test records are automatically moved to
“unspecific segment” folder of the segment records. For information on uploading
test records, see chapter 8.5.

Customized segment record: Contains offline generated physical layer limit values.
Values are used for testing multiple segments without considering the specific topology of
each tested segment. The record is used as “typical” segment information and contains
the limit values of the worst case segment with longest cable length and maximum
number of devices.
•
•

Generated test records are linked to “customized segment record”.
When uploaded onto the PC, generated test records are automatically moved to the
“customized segment record” folder of the test records. For information on uploading
test records, see chapter 8.5.
■ Specific segment records: Offline generated segment records that contain all relevant
information on a specific segment.
Generated test records are linked to “specific segment record”
When uploaded onto the PC, generated test records are automatically moved to the
“specific segment record”. For information on uploading test records, see chapter
8.5.

2016-03

•
•
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7.3

Segment Commissioning
The commission segment wizard automatically tests and validates a segment. In the course of
it, the wizard captures and stores all the relevant physical layer parameters.
■

■

If a segment record contains limit values derived from a given topology: The commission
segment wizard first compares measured values with the limit values. Based on the
results of the measurement, the limit values are adjusted for subsequent early detection of
any deviation.
If a segment record does not contain any limit values: The commission segment wizard
first compares measured values with the limit values defined by the fieldbus standard
IEC 61158. Based on the results of the measurement, the limit values are adjusted for
future measurements.

The result is stored in a commissioning record. Subsequent segment checkouts during
maintenance or segment troubleshooting always refer to these limit values to compare the
measured values against them. In case of deviations, the possible root causes are determined
by a built-in expert system.
The results of a commissioned segment are stored in a test record and, if available, are linked
to a segment record. The segment record is categorized as it is commissioned.

Commissioning a Segment with the Commissioning Wizard
1. Go to the Commission segment menu item.
If a segment record was loaded on the handheld: The segment records selection menu
appears. 
If no records were loaded on the handheld: The unspecific segment record is automatically
selected.
2. Press the OK key.

2016-03

3. If segment records selection menu appears, proceed as follows: In order to navigate
through the data records list, use the Up and Down arrow keys. Select a specific record with
the OK key.
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In the subsequent menu you can change the settings for the commission segment
function:

1

Read device info: Includes information for all detected devices in the data record:
■ Tag description
■

Device type

■

Device manufacturer

NOTE: This function requires communication of the handheld. When communicating, the
handheld takes 10 mA from the fieldbus.
2

Include osci recordings: Includes oscilloscope traces for each device in the data
record:
■ Preamble
■

Start of frame

■

1 data bit

■

End of frame

4. In order to navigate through the data records list, use the Up and Down arrow keys. Select a
specific record with the OK key.

2016-03

If you selected the Read device info option, FDH–1 intends to activate its
communication function. The communication function is used for connecting to the
segment devices and actively collecting device information.
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5. In case you want to abort this action and go back to the commission segment menu: press
the Cancel key. 
Otherwise, press the OK key to proceed.
FDH-1 begins to capture all relevant information from the segment. The result is
displayed on the screen.
6. If the number of detected devices matches the number of devices connected to the
segment: press the OK key to proceed. 
If the number does not match yet, wait for FDH-1 to detect all devices.

FDH-1 commissions the segment and records the physical layer data. 
The result is displayed on the screen. 
Note: In case of a fault, follow the instructions of the expert system. The results of the check
segment are stored in a test record.

7. Press the OK key to proceed.

2016-03

FDH-1 issues a test record ID. This ID is for tracking the record after uploading it onto the
PC.
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7.4

Segment Check
The segment check function captures and evaluates all relevant physical layer values of a
segment. The segment record is downloaded onto FDH-1. The measured values are
compared to the limit values captured during commissioning of that segment.
If no commissioning record is available, a set of standard limit values derived from the fieldbus
standard IEC 61158–2 is used in order to evaluate the segment.
The values measured throughout the segment check are compared with limit values that are
derived from either of the following sources:
■

A specific segment record that was previously downloaded to the handheld

■

The customized segment record

■

If the unspecific segment record is used: The fieldbus standard IEC 61158–2

Checking a Segment with the Check Segment Wizard
1. Go to the Check segment menu item.
If a segment record was loaded on the handheld: The segment records selection menu
appears. 
If no records were loaded on the handheld: The unspecific segment record is automatically
selected.
2. Press the OK key.
3. If segment records selection menu appears, proceed as follows: In order to navigate
through the data records list, use the Up and Down arrow keys. Select a specific record with
the OK key.

2016-03

In the subsequent menu you can change the settings for the commission segment
function:
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1

Read device info: Includes information for all detected devices in the data record:
■ Tag description
■

Device type

■

Device manufacturer

NOTE: This function requires communication of the handheld. When communicating, the
handheld takes 10 mA from the fieldbus.
2

Include osci recordings: Includes oscilloscope traces for each device in the data
record:
■ Preamble
■

Start of frame

■

1 data bit

■

End of frame

4. In order to navigate through the data records list, use the Up and Down arrow keys. Select a
specific record with the OK key.
If you selected the Read device info option, FDH–1 intends to activate its
communication function. The communication function is used for connecting to the
segment devices and actively collecting device information.

5. In case you want to abort this action and go back to the check segment menu: press the
Cancel key. 
Otherwise, press the OK key to proceed.

2016-03

FDH-1 checks the segment and records the physical layer data. 
The result is displayed on the screen. 
Note: In case of a fault, follow the instructions of the expert system. The results of the check
segment are stored in a test record.
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6. Press the OK key to proceed.
FDH-1 issues a test record ID. This ID is for tracking the record after uploading it onto the
PC.

7.5

Advanced Tests

7.5.1

Oscilloscope
In order to use the oscilloscope functions, in the main menu go to Advanced test >
Oscilloscope.

2016-03

FDH 1 offers a range of trigger conditions for the built-in oscilloscope. The following trigger
functions are available:
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Setting a Trigger on Device
1. To view a Communication telegram trace, from the list of functions select Trigger on device.
The trigger on device menu offers a list of detected devices to choose from.

2. In order to select a device, use the Up and Down arrow keys. In order to start the
oscilloscope recording, press the OK key.
The ‘Communication telegram’ trace of the selected device is displayed on the LC
display. For further information on the oscilloscope trace screen, see chapter 7.5.2.

Setting a Trigger on Error
1. To view telegrams related to an error, from the list of functions select Trigger on error. The
trigger on error menu offers a list of trigger conditions:

■

CRC error: If a CRC error in a telegram is detected, the function starts the oscilloscope
record.

■

Framing error: If a framing error of a telegram is detected, the function starts the
oscilloscope record.

■

Maintenance required: If the signal level, jitter, noise, or device coupler alarms exceed a
maintenance limit, the function starts the oscilloscope record.

■

Out of specification: If the signal level, jitter, noise, or device coupler alarms exceed an
out-of-specification limit, the function starts the oscilloscope record.

2. In order to select one or more error trigger conditions, use the Up and Down arrow keys. In
order to activate or deactivate the trigger condition: press the OK key. 
Available trigger conditions: CRC error, Framing error, or Maintenance and out of
specification.
3. In order to start the oscilloscope recording: press the OK key.

2016-03

If FDH–1 finds a trigger condition, the affected telegram is displayed on the LC display.
For further information on the oscilloscope trace screen, see chapter 7.5.2.
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Setting an Advanced Trigger
The advanced trigger function enables you to visualize the communication signal on an
external oscilloscope. Therefore, the handheld has an external hardware trigger output. This
output can be used with a special cable for connecting the trigger output to an oscilloscope
trigger input. The advanced trigger menu controls the external hardware trigger, as long as the
handheld menu is active.
The trigger is a 1 V positive pulse with a duration of 0.5 µsec.
Prerequisite: Connection cable with 2 banana plugs. 
Order code for this accessory: ACC–FDH–CTRG
1. To connect FDH–1 to an external oscilloscope, from the list of functions select Advanced
trigger.

Settings for advanced trigger conditions
2. In order to navigate to the “Selected address” setting, use the Up and Down arrow keys. In
order to select the “Selected address” option: press the OK key.

3. Select either of the following options: 
- “All addresses”: If a telegram or an error of the defined type(s) is detected, the trigger
output is set independently of the device address.
- “Select from live list”: Select a device currently connected to the segment. 
- “Select any address”: Select an address from the fieldbus-specific address range.

2016-03

4. In order to activate or deactivate the trigger conditions for telegram/error: Use the Up and
Down arrow keys and press the OK key.
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Trigger Events for FOUNDATION Fieldbus
Name

Result

Pass token to (address)

Trigger on a pass token telegram to address.

Probe node to (address)

Trigger on a probe node telegram to address.

Pass token usage (from address)

Trigger on telegrams after a device received a
pass token telegram.

Missing PT usage (from address)

Trigger if a pass token telegram was sent but
no probe node response is detected with the
next frame.

Probe node response (from address)

Trigger on a probe node telegram from the
specified address.

Missing probe node response (from address) Trigger on a missing probe node response
telegram from a specified address.
Claim LAS (from address)

Trigger if a claim LAS telegram is detected.

Transfer LAS (to address)

Trigger if a Transfer LAS telegram is detected.

Maintenance required by address

Trigger if a maintenance-required telegram by
a device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

Out of specification by address

Trigger if an out-of-specification telegram by a
device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

CRC error

Trigger on a CRC error in a telegram.

Framing error

Trigger on a framing error in a telegram.

Trigger Events for PROFIBUS PA
Result

Request from (address)

Trigger on a request telegram.

Response from (address)

Trigger on a response telegram.

Missing response (from address)

Trigger if a device does not respond to a
request telegram.

Pass token to (address)

Trigger on a pass token telegram to “address”.

Missing PT response (from address)

Trigger if a master does not respond to a pass
token telegram.

Maintenance required by address

Trigger if a maintenance-required telegram by
a device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

Out of specification by address

Trigger if an out-of-specification telegram by a
device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

CRC error

Trigger on a CRC error in a telegram.

Framing error

Trigger on a framing error in a telegram.

2016-03

Name
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7.5.2

Oscilloscope Trace Screen
The oscilloscope screen is divided in 3 parts: Top status line, trace section, bottom status line.

1

2

3

1

Screen section top status line: The top status line is the standard status line.
see chapter 2.3.

2

Screen section trace view: The trace section displays details of the captured trace. 
To find out how to operate this section see "Navigating through and Storing a Screen
Trace View" on page 56.

3

Screen section bottom status line: The bottom status line displays details of the telegram
displayed.
see image on page 57.

Navigating through and Storing a Screen Trace View
Use the navigation keys to scroll through the captured trace. In order to store a trace, the record
memory has to be empty.
1. In order to page through the trace and view the following information, use the Right arrow
key: beginning of the telegram, preamble, start of frame sequence, middle of the telegram,
end of frame sequence and end of telegram.
2. In order to scroll through the telegram until the beginning or the end of the telegram, use the
Up and Down arrow keys.
3. In order to change the zoom level, use the OK key.
4. In order to scroll through the telegram, use the arrow keys.
In the detailed view, use the Up and Down arrow keys to navigate continuously through the
telegram.

2016-03

5. In order to save the trace in an oscilloscope record, press the OK key for 1 second.
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Screen Trace Section Detailed View
If the ‘Detailed view’ is activated, the trace section is split into 2 parts:
1

2

1

The left part displays the trace in a lower resolution with an overlaid rectangle.

2

The right section displays the trace part that is framed by the rectangle, in a 0.5 bit time
resolution. In order to navigate the rectangle through the trace, use the arrow keys.

Details on the Screen Section Bottom Status Line
The bottom status line shows details of the telegram currently displayed.

2016-03

1

2

3

4

1

Address of the device in the telegram: ADR: 124

2

Voltage zoom level: + or - 0.625 V

3

The following telegram details are displayed: 
PRE = preamble 
SOF = start of frame sequence 
MID = middle of the telegram 
EOF = end of frame sequence 
END = end of the telegram (last bit) 
Alternatively, if a trigger is used, the following telegram details are displayed:
TRG = error displayed with the following context: 
-10–bit times | TRG error condition | +10–bit times

4

Detail: The number of bits shown on the screen, e. g., 4 bits or detail.
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7.5.3

Failure Margin Test
In order to determine failure margins of devices on the segment, in the main menu go to
Advanced test > Failure margin test.
FDH–1 can determine the failure margin of each installed device.
FDH-1 changes the signal amplitude, jitter, and noise of the data sent to each individual
fieldbus device to a level where the fieldbus device starts to fail. This way, the upper limits for
each device can be determined, and the ‘weaker’ fieldbus devices in a fieldbus installation can
be identified. The failure margin test results are stored in a failure margin record, and if
available, referenced to a segment record.
Note!
Noise Injection
Injecting noise into the segment disturbs all communication! Therefore, the failure margin test
may only be performed if the segment is in installation or in maintenance mode.

In order to determine the failure margin, you can select between the following modes:
■

Manual mode

■

Automatic mode

■

Automatic + Noise

Testing the Failure Margin in Manual Mode
1. In order to test a specific device for fault tolerance, in the failure margin test menu, select
Manual.

A list of all detected devices is displayed.
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2. FDH–1 asks you to activate the communication function. The communication function is
used for actively communicating with the segment devices. 
In case you want to abort this action and return to the failure margin test menu: press the
Cancel key. 
Otherwise, press the OK key to proceed.
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3. In order to select a device: Use the Up and Down arrow keys to scroll through the list. In
order to select the device, press the OK key.
A device-specific screen appears with the physical layer value limits used for the actual
device under test.

The chosen device is continuously tested with the given values for signal level, jitter, and noise.
4. To change a specific value: Select the physical layer parameter with Up and Down arrow
keys and press the OK key.

List of Values for Physical Layer Parameters
For each physical layer parameter, you can choose from the following list of values:
■

Communication signal level (“Signal Level”): Value to test the device for robustness
against low signal receive levels. Signal levels can be changed to several discrete values
between 760 mV and 95 mV.

■

Signal Jitter (“Jitter”): Value to test the device for its robustness against signal receive jitter.
Jitter values can be changed to several discrete values between 0.5 µsec and 8 µsec.

■

“Noise Level”: Noise signal injected into the segment. The signal level of the noise can be
changed to several discrete values between 24 mV and 120 mV.

■

Noise Frequency (“Noise Frequ”): Noise signal injected into the segment. The frequency
of the noise can be changed between 31 kHz and 125 kHz, or switched off altogether.

Testing the Failure Margin in Automatic Mode
The automatic failure margin test automatically captures the failure tolerance of the segment.
For this, the function changes signal amplitude and jitter for individual devices to values at
which communication starts to fail. The test result is stored in a failure margin record for further
analysis.
1. In order to automatically test the complete segment, in the failure margin test menu, select
Automatic.
2016-03

2. Press the OK key to continue.
3. View a list of stored segment records: Press the OK key.
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4. Navigate through the segment records list: Use the Up and Down arrow keys.
5. Select a segment record: press the OK key.

6. FDH–1 asks you to activate the communication function. The communication function is
used for actively communicating with the segment devices. 
In case you want to abort this action and return to the failure margin test menu: press the
Cancel key. 
Otherwise, press the OK key to proceed.

A list of all detected devices is displayed. Wait until FDH–1 has identified all devices
connected to the segment.
7. Press the OK key to proceed.

2016-03

The automatic failure margin test is launched. During the test, the physical layer values
under test are displayed on the screen.
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8. Wait until the testing is complete.
The summary result and a test record ID are issued. Detailed information can be viewed
with FDH–1 Manager after uploading the test record onto the PC.

Testing the Failure Margin in Automatic+Noise Mode
In order to automatically test the complete segment including the noise test, in the failure
margin test menu select Automatic+Noise.
The automatic + noise failure margin test is similar to the automatic failure margin test, despite
that during the test, the segment is exposed to noise.
Note!
Failure Margin Test Duration
In order to determine the sensitivity of the segment to noise reliably, this test takes up to
approx. 10 min.

Note!
Noise Injection
Injecting noise into the segment disrupts communication during the time the segment is tested.
Noise is injected into the segment at 2 different frequencies: 31.25 kHz or 125 kHz.
Noise levels range from 20 mV … 120 mV.

2016-03

The resulting record offers an overall 3 ... 1 star rating of the test. The rating is based on the
requirements of a Pepperl+Fuchs ADM device. The rating details are explained on the first
page of the failure margin test record.
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7.5.4

Coupler Spur Electronic Test
In order to verify the electronic circuit of a device coupler with electronic short circuit current
limitation, in the main menu go to Advanced test > Coupler spur test.

Testing the Spur of a Device Coupler
Prerequisite: FDH-1 is connected to the spur to be tested.
1. In order to launch the spur test, press the OK key.
A warning message appears: “The device coupler may shut down the spur during this
test. This restarts any attached field devices and FDH-1. Continue?” The spur current is
increased to a level the short circuit protection circuit isolates the spur or limit the output
current to a fixed value, depending on the device coupler short circuit protection
characteristic.

2. Press the OK key to proceed.
When powering FDH–1 via the segment: When the spur shuts off, FDH–1 goes into reset
mode. When the spur is switched on again, FDH–1 powers up and shows the result on the
screen. 
When powering FDH–1 via battery / USB: When the spur shuts off, the test result instantly
appears on the LC display. If the tested spur has a device connected to it, the displayed
short circuit current does not include the device current.

2016-03

The maximum short circuit current the handheld can test for is 60 mA. If FDH–1 reaches 60 mA
without triggering the short circuit current limitation circuit, the test issues an error:
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7.5.5

History Recording
The history recording function logs all relevant physical layer information of a segment in a
defined interval. History recording continues until the recording is interrupted or stopped, or the
FDH-1 memory is full.
In case the handheld is powered by a battery: Consider the load condition of the battery when
defining the history recording time.
Recorded information can be uploaded to FDH–1 Manager, visualized with Microsoft Excel,
and stored in a segment record.
For information on uploading records to FDH–1 Manager, see chapter 8.5.

Using the History Recording Function
1. In order to log relevant physical layer information for a segment regularly, in the main menu
go to Advanced test > History recording.
2. In order to start history recording: Press the OK key.
The segment records selection menu appears:

3. Choose from either of the following records by navigating with the Up and Down arrow
keys, and selecting with the OK key: 
- Data record if a segment record was previously downloaded onto FDH–1 
- Unspecific segment record 
- Customized segment record

2016-03

The history recording menu begins.
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■

Calculated recording length: Calculated duration of the history recording based on the
recording interval and the available memory to store the data in a test record.

■

Recording interval: Duration of the measurement interval once the minimum and
maximum values are stored in the test record.

■

Endless recording: Minimum and maximum measured values in an interval are stored in
a circular buffer. Once the memory is full, the values measured in the first interval are
overwritten with the last measured values.

4. Navigate with the Up and Down arrow keys to the menu entry “Proceed” and press the OK
key.
The history recording is started. If history recording was set to endless recording, the
time elapsing during the history recording is displayed. Otherwise both the elapsed and
remaining time of the history recording are displayed.

5. In order to interrupt the history recording and store the measures values in a test record:
Press the OK or Cancel key.

2016-03

FDH-1 issues a history data record ID. This ID is for tracking the record after uploading it
onto the PC.
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7.5.6

Wiring Check
In order to test the cable used in the fieldbus installation for its suitability as trunk cable, in the
main menu use the Advanced test > Wiring check functions.
Prerequisites: A fieldbus power supply (min. 30 mA) is connected and powered. The cable to
be used as trunk is terminated by 2 terminators, 1 at each end to the cable. 2 FDH–1 devices
are connected to the trunk cable, 1 at each end of it.

PS
T

T

1. Configure the first FDH–1 to run in the “Wiring check master” mode.
2. Configure the second FDH–1 to run in the “Wiring check slave” mode.
The test results are shown on the FDH–1 LC display running in the master mode.

Setting Device to Wiring Check Master Mode
1. In order to configure the first FDH–1 as master, in the main menu go to Advanced test >
Wiring check master.
2. In order to configure FDH-1 as master for the wiring check: Press the OK key.
3. If the second FDH–1 has not been connected yet: FDH–1 prompts you to connect an extra
FDH–1 to the other end of the trunk in the wiring check slave mode. 
Connect the second FDH-1 accordingly.

4. Press the OK key to launch the test. The test result is displayed on the LC display. If faults
are detected, the causes of the faults are issued.
5. In order to go back to the main menu: Press the Cancel key.

2016-03

FDH-1 issues a result message.
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Setting Device to Wiring Check Slave Mode
1. In order to configure the first FDH–1 as master, in the main menu go to Advanced test >
Wiring check slave.
2. In order to configure FDH-1 as slave for the wiring check: Press the OK key.
In slave mode, no further user interaction is required.
3. When the wiring check is complete: Press the Cancel key to go back to the main menu.

7.6

Settings

7.6.1

Test Record Memory
FDH-1 offers a memory function to store the results of commissioning, check segment, failure
margin test, history recordings, and oscilloscope traces. See chapter 2.5.

2016-03

Use the test record memory menu to view stored test records and delete test record if memory
space is required.
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Viewing or Deleting All Test Records
1. In order to view test records, go to Settings > Test record memory.

1

2

3

4

1

Number used/ Numbers total: Number of free memory blocks

2

Number: Number of memory blocks used by the test record

3

Test record type:
■ CHK Check segment

4

■

COM commissioning

■

FM failure margin

■

Oscilloscope record

■

History record

Segment record:
■ Unspecific
■

Customized

■

Tag of specific segment

2. In order to delete all test records: Press the OK key for 1 ... 2 seconds.

Selecting a Test Record
1. In order to select the test record: Use the Up and Down keys.

2016-03

2. For memory details on a test record: Press the OK key.

■

ID: Identifies the test record once it is uploaded onto the PC.

■

Type: Check segment, Commissioning, Failure margin, History, Oscilloscope.
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■
■

Size: Shows the number of memory blocks the test record uses.
Segment record type (unspecific, customized, tag of specific segment): Shows the
segment record that was used as limit value reference against which the segment was
tested.

3. In order to delete a test record: Press the OK key for 1 ..2 seconds.
4. Otherwise press the Cancel key to continue.

7.6.2

Fieldbus Type
You can set the fieldbus type that you want to use the handheld with.

Setting the Fieldbus Type
1. In order to set the fieldbus type used, in the main menu go to Settings > Fieldbus type.
2. In order to navigate through the available fieldbus types: Use the Up and Down arrow keys.
3. In order to activate the fieldbus type: Press the OK key.

7.6.3

Fieldbus Communication
In order to set different fieldbus-dependent options, go to the menu Settings > Fieldbus
communication.

Using Communication Settings for FOUNDATION Fieldbus
1. Select with OK key to enable or enter the following options.

2. "Communication enabled" option: Enables the communication of FDH-1. Communication is
required to read device info.

2016-03

3. “Change default addr.” option: Use option to assign a device with a default address to a
valid address. Starting with the lowest address defined in “auto address start” function,
FDH–1 changes default addresses to valid addresses. If the device does not contain a tag
description, FDH-1 assigns a physical tag description in order to change the default
address.
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4. “Auto address start” option: Defines the lowest address that FDH-1 uses to assign
addresses to devices using default address. 
1. Activate the address selection window: Press the OK key. 
2. Scroll through the list of device addresses: Use the Up and Down arrow keys. 
3. Select a device address: Press the OK key.
5. “Clear FF addresses” option: Set devices to the default address. A device address list is
generated on the fly that optionally shows the tag descriptions. 
1. Launch the clear FF address function: Press the OK key. 
2. Read the tag description of the detected devices: Press the OK key again. The address is
cleared.
3. Return to the previous menu, press the Cancel key. The list of the detected devices
appears. 
4. Select the device you want to assign the default address: Use the Up and Down arrow
keys. 
5. Press the OK key to assign the default address.

Using Communication Settings for PROFIBUS PA
1. Select with OK key to enable or enter the following options.

2. “Communication enabled” option: Enables the communication of FDH-1. FDH-1 becomes
fieldbus master. Communication is required to read device info.
From PROFIBUS PA profile devices that support the I&M PROFIBUS function, FDH–1 can
read the following information: Tag description, order ID, serial number, and
manufacturer ID. 
From segment devices that do not support the I&M PROFIBUS functions, FDH–1 can read
the following information from the physical block: Tag description, order ID, serial number,
and manufacturer ID. 

OR
3. “Retries” option: Set the maximum number of retries FDH-1 uses when in fieldbus master
mode. 
1. Activate the retry selection window, press the OK key. 
2. Navigate to maximum number of retries value: Use the Up and Down arrow keys. 
3. Select maximum value: Press the OK key.

OR

2016-03

4. “Master address” option: Define the address that FDH-1 uses when in fieldbus master
mode. 
1. Activate the master address selection window: Press the OK key. 
2. Select the lowest device address: Use the Up and Down keys 
3. Confirm device address selection: Press the OK key.
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7.6.4

Device Settings
In order to set the auto-off time, the battery type, and the LC display visibility for the handheld,
in the main menu go to Settings > FDH–1 settings.

Setting Auto-Off Time
Set the time that passes until FDH-1 goes into auto-off if the handheld is powered with a
battery.
Scroll through the preset time options: Use the OK key to select the auto-off time.

Setting the Battery Type
Choose the battery type used; disposable or rechargeable. This setting is required to correctly
indicate the charge state of the battery.
1. Scroll through the battery type options: Use the OK key.
2. Set the battery option required: Press the OK key.

Setting the Low Temperature Mode
Adjust the LC display for better visibility at low temperatures less than –10 C°.
Activate the low temperature setting: Press the OK key.

7.6.5

About FDH-1
You can view the about menu for information on the handheld:

■

Device tag description. By using FDH–1 Manager, the tag description, an ASCII 32characters long string, can be stored in FDH–1.
For information on changing the tag description, see chapter 8.14.9.
Serial number of the handheld

■

Firmware version of the handheld
2016-03

■
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8

FDH-1 Manager Software
The following chapter describes the FDH-1 Manager PC software.
The software can be used for all use cases as described in the following chapters:
■

Assistance with segment troubleshooting, .

■

Assistance with segment commissioning, see chapter 6.5.

■

Support with maintenance tasks, see chapter 6.6.

Moreover, FDH–1 Manager offers the additional functionalities beyond the scope of the
firmware to assist you with the following tasks:

8.1

■

Administration of measurement data and records in the database: upload test records or
download segment records for live measurements.

■

FDH–1 administration: Firmware updates, language downloads, etc.

■

Using extended trigger functionality for the fieldbus oscilloscope, e.g., an external
hardware trigger.

Installation
The following chapter explains how to install FDH–1 Manager software on your PC.

Installing the PC Software
The installation file is included in a ZIP file together with the release notes. It is available from
www.pepperl-fuchs.com or from the data carrier included in the delivery.
1. From the ZIP file extract the file FDH1ManagerSetup.exe and double-click the file to start
the installation.
The installation setup menu opens. Click Next.

2016-03

Figure 8.1

FDH–1 Manager software installation setup

2. Read the end-user license agreement and accept it to proceed. Click Next.
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Figure 8.2

FDH–1 Manager software license agreement

Figure 8.3
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FDH–1 Manager software installation destination folder
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3. Determine the folder the software is to be installed in, and click Next.
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The software program will be installed.

Figure 8.4

FDH–1 Manager software installation process

2016-03

4. If the installation process was completed successfully, a confirmation message appears:

Figure 8.5

FDH–1 Manager software, finalizing installation process
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5. In order to activate a premium license, see "Activating or Adding a License Key" on page
138.

Loading or Creating a New Database
1. Upon completing the installation, you are asked to load or create a database.

Figure 8.6

FDH–1 Manager: Load or create a database

2016-03

2. Choose whether to load an existing database or create one. Determine a location to load
the database from or save it to.
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Selecting the Fieldbus Type
Next, select the fieldbus type by clicking the respective symbol.

Figure 8.7

8.2

FDH–1 Manager: Select the fieldbus type

Use Cases for FDH-1 Manager
The following chapter describes the FDH-1 Manager use cases:

8.2.1

■

Using FDH-1 Manager as user interface, for maintenance, and troubleshooting

■

Using FDH-1 Manager for visualizing and managing test records generated with FDH-1

■

Using FDH-1 Manager for segment commissioning

■

Using FDH-1 Manager for segment check with a commissioning record

User Interface for Maintenance and Troubleshooting
Connect FDH–1 to your PC and view live measurements, execute segment maintenance, and
segment troubleshooting functions.

Using FDH-1 Manager as User Interface for Maintenance and Troubleshooting
Prerequisites: 
The fieldbus type is selected, see "Selecting the Fieldbus Type" on page 75. 
A license key is active, see chapter 8.14.13.
1. Connect FDH-1 to your PC.
2. If not available yet, create a database, see "Loading or Creating a New Database" on page
74.
3. Create a segment record, see chapter 8.4.
Or select a segment record, see chapter 8.14.1.

2016-03

4. Activate the segment record for live measurement, see "Viewing Measurement Data in
FDH-1 Manager" on page 81.
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5. Now you can view measurement data or execute maintenance or troubleshooting
functions:
- Change to the FDH-1 device-specific tab and view the online measurement data, see
chapter 8.7. 
- Open the "All Functions..." section and select any functions you would like to execute, see
chapter 8.14.
6. If you execute the check segment, commissioning, failure margin test, or an oscilloscope
recording, the test records are automatically uploaded and stored in the assigned segment
record.

8.2.2

Visualization and Management of Test Records Generated with FDH-1
After generating test records with FDH 1, connect FDH 1 to your PC and manage the test
records with FDH 1 Manager.

Using FDH-1 Manager to Visualize and Manage Test Records Generated with
FDH-1
Prerequisites: 
Test records are available on FDH-1. The referenced segment record is selected while a wizard
is running, see "Viewing Measurement Data in FDH-1 Manager" on page 81.
The fieldbus type is selected, see "Selecting the Fieldbus Type" on page 75. 
A license key is active, see chapter 8.14.13.
1. Connect FDH-1 to your PC.
FDH-1 Manager automatically detects new available test records stored on FDH-1. You
are asked to upload the test record(s),
see Figure 8.61 on page 128.
2. If you proceed, the test record(s) are uploaded and stored automatically in the segment
record that was assigned while the wizard was running.
3. Change to the segment database view, navigate to the required segment record in the
segment topology section, see chapter 8.5.
4. In order to visualize a test record, in the test record and documents section double-click the
test record.

8.2.3

Segment Commissioning
Commission a segment with FDH–1 Manager or prepare data for commissioning with FDH–1
Manager to be uploaded to the handheld.

Using FDH-1 Manager for Direct Segment Commissioning
Prerequisites: 
For a description of the different possibilities for segment commissioning, see chapter 6.5.1. 
The fieldbus type is selected, see "Selecting the Fieldbus Type" on page 75. 
A license key is active, see chapter 8.14.13.
1. Connect FDH-1 to your PC.
2. If not available yet, create a database, see "Loading or Creating a New Database" on page
74.
3. If detailed information is available on the topology of the segment to be commissioned,
generate a segment record, see chapter 8.4.
4. Edit the segment record data by adding topology information, see chapter 8.6.1.
5. If available, add field device-specific data, see chapter 8.6.4.
6. If you want to use FDH-1 Manager for commissioning, select the segment record for live
measurement, see "Viewing Measurement Data in FDH-1 Manager" on page 81.
The resulting commissioning record is automatically uploaded and stored in the
segment record assigned.

76

2016-03

7. In the "All Functions..." section, launch Segment commissioning, see chapter 8.14.2.

Fieldbus Diagnostic Handheld
FDH-1 Manager Software

Using FDH-1 Manager for Handheld Segment Commissioning
Prerequisites: 
For a description of the different possibilities for segment commissioning, see chapter 6.5.1. 
The fieldbus type is selected, see "Selecting the Fieldbus Type" on page 75. 
A license key is active, see chapter 8.14.13.
1. Connect FDH-1 to your PC.
2. If not available yet, create a new database, see "Loading or Creating a New Database" on
page 74.
3. If detailed information is available on the topology of the segment to be commissioned,
generate a segment record, see chapter 8.4.
4. Edit the segment record data by adding topology information, see chapter 8.6.1.
5. If available, add field device-specific data, see chapter 8.6.4.
6. If you intend to perform the commissioning with FDH-1 only, go to the “All functions” section
and launch the function Download segment records, see chapter 8.14.10.
7. Disconnect FDH-1 from the PC and connect FDH-1 to the segment. 
It is recommendable to connect FDH-1 at the end of the segment with the host/power
supply. For further segment checkouts, the captured data can be used for comparison and
evaluation. While the check segment function is running, FDH-1 must be connected at the
same point of the segment as during commissioning.
8. Perform the commissioning with FDH-1, see chapter 7.3.
9. After the commissioning is completed, reconnect FDH-1 to the PC and upload the
commissioning test record, see chapter 8.14.9.

8.2.4

Segment Check with a Commissioning Record
Check a segment with FDH–1 Manager or download data for checking a segment to the
handheld, and upload the results of the segment check.

Using FDH-1 Manager for a Direct Segment Check with a Commissioning
Record
Prerequisites: 
A commissioning record is already available, see chapter 8.14.2. 
The fieldbus type is selected, see "Selecting the Fieldbus Type" on page 75. 
A license key is active, see chapter 8.14.13.
1. Connect FDH-1 to your PC.
2. Choose the segment record from the segment database the check segment function is to
be performed for, see chapter 8.5.
3. If you want to use FDH-1 Manager to launch the check segment function, select the
respective segment record for live measurement, see "Viewing Measurement Data in FDH1 Manager" on page 81.
4. Connect FDH-1 to the segment at the same point as for commissioning to make the
measurement results comparable.
5. Go to the "All Functions..." section and launch the check segment wizard, see chapter
8.14.3.
Once the segment check is complete, the check segment record is automatically
uploaded and stored in the segment record assigned.

2016-03

6. Go to the segment database, select the uploaded check segment record and double-click it
to visualize the results.
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Using FDH-1 Manager for a Handheld Segment Check with a Commissioning
Record
Prerequisites: 
A commissioning record is already available, see chapter 8.14.2. 
The fieldbus type is selected, see "Selecting the Fieldbus Type" on page 75. 
A license key is active, see chapter 8.14.13.
1. Connect FDH-1 to your PC.
2. Choose the segment record from the segment database the check segment function is to
be performed for, see chapter 8.5.
3. If you want to launch the check segment wizard with FDH-1 only, go to the "All Functions..."
section and select the download segment record function, see chapter 8.14.10.
4. Once the download is complete, disconnect FDH-1 from your PC.
5. Connect FDH-1 to the segment at the same point as for commissioning to make the
measurement results comparable.
6. Launch the check segment wizard in FDH-1, choose the segment record you have
downloaded before, and continue to perform the check segment wizard, see chapter 7.4.
7. When the check segment wizard is finished, connect FDH-1 to your PC again.
The check segment record is uploaded and automatically stored in the segment record
assigned.
8. Go to the segment database, select the uploaded check segment record and double-click it
to visualize the results.

8.3

Segment Database for Segment Record Management
The FDH-1 segment database tab can be used for the following activities:
Retrieve information on stored records

■

Edit segment record data

■

Select segment records for live measurements

■

Build and manage the plant structure in order to store the records accordingly

2016-03

■
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Figure 8.8

1

8.4

FDH–1 Manager: Segment database tab

Main menu with the following options:
■ File>Open database
■

File>New database

■

File>Open recent databases

■

File>Exit

■

Help> Help on FDH–1 Manager

■

Help>Information on FDH–1 Manager

2

Left-hand tabs: Device-specific tab, Segment database tab, and any open records.

3

Structuring section: Used to model the plant structure and sort specific segment records
into the structure as needed. Unspecific or customized segment records cannot be structured.

4

General section: Contains the segment tag and a description. Both can be edited via the
topology settings.

5

Configuration section: Applies to specific and customized segment records only. Informs
on the commissioning status of the segment. Enables editing segment record data and
selecting a segment record for live measurements with the connected FDH–1.

6

Segment test records and documents: Lists all segment record information and any documents or reports connected to it.

Plant Structure
Navigation: Segment Database tab

2016-03

You can use FDH–1 Manager software to model the plant structure to reflect the actual
structure of your plant. This way, you can associate the test records exactly to the segments
they belong to.
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Modeling the Plant Structure
In order to model the plant structure, proceed as follows:
1. Right-click on an item in the directory structure.
A context menu opens.

Figure 8.9

■

■

FDH–1 Manager: Plant structure elements, segment records, folders, and top icon
menu

Segment record: Represents a segment of the plant. The segment record contains all
the segment-specific data, e.g., test records, history test records. Segment records can
be used for live measurements.
Folder: Contains folders or segment records and can be used to model the plant
structure.

Icons

Explanation
Create segment record
Create folder
Move existing items
Rename existing items
Delete existing items

2. Choose from the context menu or from the identical top icon menu the required activity. You
can either create a segment record or create a folder.

2016-03

3. If needed, you can add a description to each item. Click Edit and in the text field that opens,
enter the description. Save with OK.
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Figure 8.10

8.5

FDH–1 Manager: Plant topology, add a description

Storing and Viewing Records in the Segment Database
With FDH–1 Manager, test records can be uploaded to the segment database, and segment
records can be downloaded to the handheld or viewed during testing.

Uploading Test Records
In order to upload a test record, go to All Functions… > Upload test record.
For details, see chapter 8.14.9.

Downloading Segment Records
In order to download a segment record, go to All Functions… > Download segment record.
For details, see chapter 8.14.10.

Viewing Segment Records
Go to the segment database tab.

Viewing Measurement Data in FDH-1 Manager
1. Go to the Segment Database tab.
2. Browse the plant structure: Click a segment record you are interested in.
3. Select the following button: Select this segment record for live measurements with the
connected FDH–1.

2016-03

This brings you to the FDH–1 device tab for this record. You can view the segment health
while the measurement takes place. For details, see chapter 8.7.
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History Records
A history record is a type of segment data record that can be uploaded onto the segment
database, the same way as any other types of segment records from FDH–1. History records
enable you to collect and store data in defined recording intervals, usually over longer periods.
This information helps you to observe latent deteriorations of segments or single field devices
that cannot be tracked easily otherwise.. The minimum and maximum value of each measured
value within the recording interval are stored as 1 data set.
For information on history recording, see chapter 7.5.5.
FDH–1 Manager offers an export function that lets you convert history records into a commonly
used document format, in order to use this data for your own calculations. History records can
be exported as Microsoft® Excel documents, comma-separated values (CSV file), or as binary
history files (HIS).

Exporting and Viewing History Records
In order to export history records, proceed as follows:
1. In the segment test records and documents section of the segment record, double-click the
history record in question.
The history test record tab opens with the export options on it.

Figure 8.11

FDH-1 Manager, history record export options

2. Select the required file format and in the Save as dialog that opens enter a file name.
3. Click Next to continue.
4. After the export is complete, you can close the export function or select Restart to export
the history test record for another segment.

2016-03

5. In order to directly view the report contents in Excel, click Open with Excel.'
The export to Microsoft® Excel feature enables fast and easy data exchange and
reformatting of your physical layer data. 
The physical layer data is exported into a special template. This template is designed to
provide a detailed overview of all relevant parameters and enables you to create diagrams
with 1 click.
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An Excel file with the contents of the history test record appears:

Figure 8.12

8.6

FDH-1 Manager, history record Excel export

Editing Segment Record Data in the Segment Database
Navigation: Segment Database tab > sections General, Configuration, Segment test
records and documents
In the segment database tab, you have options to edit the segment record data. The options
are:
General

Edit: Edit the description of a segment, add a note to a segment.
Configuration

2016-03

■

Edit segment record data …: Parameterize the segment details offline: Topology and
Devices. Adjust and fine-tune all the settings based on the test record that FDH–1 has
recorded. Add more field devices and adjust the field device settings. In the manually
commissioned mode, you can also activate/deactivate alarms and change the limit
values of the physical layer measurement.
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■

Select this segment record for live measurements with the connected FDH–1: In
order to use a marked segment for live measurements with the connected handheld,
select this option. Choosing this option brings you to the FDH–1 device tab. There, you
see all live information for the selected segment under test. This option overrides any
possible deviating structures on the handheld. This option automatically associates any
test records on the handheld with the respective segment records of FDH–1 Manager.

Segment test records and documents

Buttons

Description
Add a note.
“Add an external document”: Opens the directory to select a file for
adding.
“Open selected document or test record”: Opens the test record or
document in the appropriate application on the PC, e.g. Excel, etc.
“Rename selected document or test record”: Use to activate a
selected item for renaming.
“Move selected document or test record to another segment”: Opens
the segment tree structure to choose a new location.

2016-03

“Delete selected document or test record from database”: Opens a
request for confirmation to delete the selected item. If confirmed, the
item is deleted.
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Editing Segment Record Data
1. In the configuration section, click Edit segment record data ...
The following dialog appears:

1

2

3

2016-03

Figure 8.13

FDH–1 Manager, editing segment record data menu overview

1

"Not commissioned": This status is automatically selected if you chose a segment
record that has not yet been commissioned. The status enables making changes to the
segment topology settings and adding, changing, or deleting devices in the segment.
The limit values for the segment and the devices connected to it are preset and derive
from the fieldbus standard IEC 61158-2 or are calculated from information on the segment topology. 
If needed, you can change the status to "Commissioned "Manual". 
"Commissioned (Manual)": This status is optional. Select this status if you decide to
make further changes to the segment record, e.g., set deviating segment limit values or
deviating signal level limits for devices in the segment. 
"Commissioned": This status is automatically selected if you chose a segment record
that is commissioned. The status enables to view the segment topology settings, the limit
values for the segment and the devices in the segment. In order to make changes to the
commissioned segment record, you can change the status and adjust the settings. 
If needed, you can change the status to "Not commissioned" or "Commissioned "Manual".
For more information on the commissioning states, see chapter 2.2.

2

Segment record data section: Topology tab, Segment limits tab, Devices tab. 
Tabs give access to different topology, alarm, and limit value settings of the physical layer
measurement.

3

Actions: Buttons OK, Cancel, and Apply.

2. Confirm your changes with OK.
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The changes are saved for the segment.
3. In order to fine-adjust the parameter settings for future commissioning, in the
commissioning status menu activate "Commissioned".

In this commissioning status, the following settings are available:
■

Segment limit parameters

■

Field device parameters

■

Device settings

4. Confirm your changes with OK.
The changes are saved for the segment.
Note!
Measuring at the Spurs of Short-Circuit Proof Device Couplers
For information on impedance deviation when measuring at the spurs of short-circuit proof
device couplers, see chapter 3.6.

8.6.1

Adjusting Segment Topology Settings
Prerequisite: The Commissioning status is "Not commissioned".
In order to adjust the topology settings for this segment, choose the radio button Use
following segment topology settings.
This activates the topology parameter settings for the segment.

FDH–1 Manager, editing segment record data, active segment topology settings

By default, the segment commissioning state is "Not commissioned". In this state, the following
settings are active:

86

2016-03

Figure 8.14

Fieldbus Diagnostic Handheld
FDH-1 Manager Software

8.6.2

■

Topology

■

Devices

Segment Topology Parameters

Parameter Options

Measure position

Power supply, Field, Spur

Power supply

List of Pepperl+Fuchs power supplies, "Other"

Device coupler types

Other, *-FB-EX*, Fieldbus coupler with
diagnostics, R4D0-FB-IA*
If a type is specified, the number of couplers
1…4 must be entered

Trunk length

Range: 1…1900 m

Trunk cable

List of cable types

Adjusting the Segment Limits
Prerequisite: The commissioning status is "Commissioned (Manual)".
Adjust the alarm limits of the segment.
Maximum/minimum hysteresis can be adjusted for:
■

Voltage

■

Unbalance

■

Minimum signal level

■

Maximum signal level

■

Noise

■

Jitter

This way, you can determine the limits for the following events:
■

Low Out of Specification

■

Low Maintenance Required

■

High Maintenance Required

■

High Out of Specification

2016-03

Decide whether to activate/deactivate the alarm for the suggested limit value for each event by
clicking onto the respective check box.
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Figure 8.15

8.6.3

FDH–1 Manager, editing segment limit settings in commissioned manual or
commissioned status

Adding or Removing Devices to the Segment
You can add or delete field devices to a segment record data. Also, you can edit information on
added devices.
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FDH–1 Manager, editing segment record data with commissioned manual or
commissioned status, devices and their settings

■

Add a device: Click the Add device icon.

■

Remove a device: Click the Remove device icon.

■

Change the device address: In the device list, click in the respective address line and
change the number manually.

2016-03

Figure 8.16
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The device information for each device is displayed on the upper right-hand side:

8.6.4

Adjusting the Field Device Parameters for the Segment
Prerequisite: The Commissioning status is "Commissioned (Manual)".

Figure 8.17

FDH–1 Manager, editing segment record data with commissioned manual or
commissioned status, devices and their settings

Adjusting Device Parameters
1. Go to the Devices tab.
2. Choose a field device from the list.
3. Enable/disable the coupler alarms:
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4. Enable/disable the alarms for the signal level limits:
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8.7

■

Out of specification low: Issue a signal alarm if the signal level falls below the low limit of
200 mV: Activate/Deactivate

■

Maintenance low: Issue a signal alarm if the signal level falls below the low limit of
400 mV: Activate/Deactivate

■

Maintenance high: Issue a signal alarm signal level exceeds the high limit of 1200 mV:
Activate/Deactivate

■

Out of specification high: Issue a signal alarm if the signal level exceeds the high limit of
1200 mV: Activate/Deactivate

■

Hysteresis: The signal level limit is 50 mV

FDH-1 Device-Specific Tab
The FDH-1 device-specific tab displays all the handheld settings and information. Upload test
records, view all handheld settings, or download adjusted settings to the handheld.

2016-03

Prerequisite: In order to view all the settings and functions, an FDH–1 must be connected to the
PC.
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Figure 8.18

1

FDH–1 Device-specific tab

Main menu with the following options:
■ File>Open database
■

File>New database

■

File>Open recent databases

■

File>Exit

■

Help> Help on FDH–1 Manager

■

Help>Information on FDH–1 Manager

2

Left-hand tabs: FDH–1 device-specific tab, Segment database tab, and any records that
can be viewed.

3

Info section: Contains information on the status of the fieldbus communication and the
segment record selected.

4

Function section: Contains fast access to related tasks and a complete pulldown menu
with all function available.

5

Window tabs: Tabs offer access to all aspects of the segment record that is selected with
FDH–1 connected to the PC (live view).
For details, see chapter 8.7.
■ Overview: Information on the overall quality of the segment.
Measurement: Information on the overall quality of the segment with
measurement values.

■

Device signal level: Information on the signal levels of the tested field devices.

■

Devices: Information on the physical layer values of each tested field device.

■

Statistics: Statistical information on fieldbus communication and timing properties

■

Oscilloscope: Advanced analysis of the fieldbus signal level during a defined time
period

Display of segment details: Displays the details of the segment record that is selected.

2016-03

6

■
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In the upper right corner of the window, the tab offers related tasks shortcut menus and a quick
access pulldown to all functions.

Figure 8.19

The All Functions... pulldown menu offers quick access to all tasks and functions that
you can carry out with FDH–1 handheld connected to FDH–1 Manager software.

2016-03

For detailed information see the following sections.
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8.8

Overview Tab
Navigation: FDH–1 Device-Specific tab > Overview tab
This information tab enables a quick overview of a segment status. It gives a brief overview on
the segment health.

Figure 8.20

FDH–1 device-specific tab: Overview

Segment quality: Information on the quality of the segment currently under test

2

Diagnostic messages: Information on the segment currently under test

3

List of possible root causes and suggested troubleshooting measures

4

Clear outdated messages button: Delete obsolete messages from the list

2016-03

1
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8.9

Measurement Tab
Navigation: FDH–1 Device-Specific tab > Measurement tab
This information tab enables fast validation of a segment record. It enables you to perform a
detailed analysis.

1

2

3

4
Figure 8.21

FDH–1 device-specific tab: Measurement

1

Segment quality: Information on the quality of the segment currently under test

2

Segment information: Tag information of the segment and current communication status

3

Segment measurement

4

Reset button: Delete measurement and history

The analog measurement values are displayed graphically as shown in the figure below.
If the segment is not commissioned, the values are classified as follows: "Excellent", "Good",
and "Out of Specification"
If the segment is commissioned, the values are classified as follows: "No Error", "Maintenance
Required", and "Out of Specification".
see Figure 8.13 on page 85.

2016-03

For information on the different commissioning statuses,
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1

6
Figure 8.22

2

3

5

4
Signal level

1

Current value

2

Range for excellent value (green)

3

Range for good value (blue)

4

Range for exceeded value (yellow)

5

Maximum value occurred during operation

6

Minimum value occurred during operation

Magnifying Glass
Click the magnifying glass to see the measured data of each field device.

Magnifying glass

2016-03

Figure 8.23
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8.10

Device Signal Level Tab
Navigation: FDH–1 Device-Specific tab > Device Signal Level tab
This tab contains a graphical overview of the different devices and their signal level.

1

2

Figure 8.24

FDH–1 device-specific tab: Device signal level

1

Device signal levels: Detailed signal level view on the devices currently under test. Use
the pulldown list to display either of the following device identification information in combination with the current device signal: device tag, device ID, device type 
Note: The view is available only if the fieldbus communication is enabled, see chapter
8.14.7.

2

Reset button: Delete measurement and history.

Note!
Measuring at the Spurs of Short-Circuit Proof Device Couplers

2016-03

For information on impedance deviation when measuring at the spurs of short-circuit proof
device couplers, see chapter 3.6.
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8.11

Devices Tab
Navigation: FDH–1 Device-Specific tab > Devices tab
The columns in the devices table contain a live view of the essential physical layer values.

1

2

Figure 8.25

FDH–1 device-specific tab: Devices

Devices: List of device measurements currently under test. These include: signal level,
noise, jitter, polarity, live list appearances, pass token losses. Use the pulldown list to display either of the following device identification information in combination with the device
measurements: device tag, device ID, device type. 
Note: The view is available only if the fieldbus communication is enabled.

2

Reset button: Delete measurement and history.

2016-03

1
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8.12

Statistics Tab
Navigation: FDH–1 Device-Specific tab > Statistics tab
This tab contains an overview of the received communication frames, errors, and other fieldbus
communication and timing properties.

Figure 8.26

8.13

FDH–1 device-specific tab: Statistics

1

Statistics: Statistical values on the diagnostic finds resulting from the segment currently
under test

2

Reset button: Delete measurements and history.

3

FOUNDATION Fieldbus communication parameters: Overview of the communication
parameters currently selected.

Oscilloscope Tab
Navigation: FDH–1 Device-Specific tab > Oscilloscope tab

8.13.1

Recording Settings
The built-in oscilloscope enables in-depth analysis of the fieldbus signal level during a defined
time period, for example, if a specific telegram type was detected or if communication issues
occurred.

Opening the Oscilloscope
To open the oscilloscope, proceed as follows:
1. Go to the FDH-1 device-specific tab.
2. Choose the tab Oscilloscope.
3. Click the Change settings ... button.

2016-03

The oscilloscope settings dialog appears.
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Figure 8.27

FDH-1 Manager device-specific tab: Oscilloscope record settings dialog

Record settings selection: 
- Use external trigger output: Select if you intend to use an external oscilloscope
- Use FDH–1 built-in oscilloscope: Select if you intend to use the oscilloscope of the
handheld firmware/PC software

2

General settings: Recording length, amplitude number of recordings, immediately open
recording Y/N.

3

Trigger options: Trigger indefinitely Y/N, Trigger timeout: 60 s (default), Automatic pretrigger time Y/N: Y = 5 ms (default)

4

Trigger events: Activate/deactivate: Select to activate. 
The trigger events "Maintenance required by address" and "Out of specification by address" can only be triggered under the following conditions:
- The built-in FDH-1 oscilloscope is used
- No other trigger events are selected 
"All addresses": Option for all trigger events. Activate/deactivate: Activated = Trigger
event triggers for all addresses. Deactivated = Trigger event triggers for the address that
is specified here.
"Voltage trigger": Activate/deactivate: Activated = Define the trigger level. 
Default = -0.625 V

2016-03

1
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8.13.2

Trigger Description
To make sure that the triggered frame is valid, every trigger event occurs at the end of the
frame.
Trigger Events for FOUNDATION Fieldbus
Name

Result

Pass token to (address)

Trigger on a pass token telegram to address.

Probe node to (address)

Trigger on a probe node telegram to address.

Pass token usage (from address)

Trigger on telegrams after a device received a
pass token telegram.

Missing PT usage (from address)

Trigger if a pass token telegram was sent but
no probe node response is detected with the
next frame.

Probe node response (from address)

Trigger on a probe node telegram from the
specified address.

Missing probe node response (from address) Trigger on a missing probe node response
telegram from a specified address.
Claim LAS (from address)

Trigger if a claim LAS telegram is detected.

Transfer LAS (to address)

Trigger if a Transfer LAS telegram is detected.

Maintenance required by address

Trigger if a maintenance-required telegram by
a device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

Out of specification by address

Trigger if an out-of-specification telegram by a
device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

CRC error

Trigger on a CRC error in a telegram.

Framing error

Trigger on a framing error in a telegram.

Trigger Events for PROFIBUS PA
Result

Request from (address)

Trigger on a request telegram.

Response from (address)

Trigger on a response telegram.

Missing response (from address)

Trigger if a device does not respond to a
request telegram.

Pass token to (address)

Trigger on a pass token telegram to “address”.

Missing PT response (from address)

Trigger if a master does not respond to a pass
token telegram.

Maintenance required by address

Trigger if a maintenance-required telegram by
a device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

Out of specification by address

Trigger if an out-of-specification telegram by a
device coupler is sent or a maintenance limit
of a physical layer parameter is exceeded.

CRC error

Trigger on a CRC error in a telegram.

Framing error

Trigger on a framing error in a telegram.

2016-03

Name
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8.13.3

Start Recording
Starting the Oscilloscope Recording
Prerequisite: In the oscilloscope settings, the option "Use FDH-1 built-in oscilloscope settings"
is activated. see chapter 8.13.1. In order to start the oscilloscope recording, proceed as
follows:
1. Go to the FDH-1 device-specific tab.
2. Choose the tab Oscilloscope.
3. Click the Start recording button.
4. Choose Start Recording.
The oscilloscope record tab appears.

Figure 8.28

FDH-1 Manager device-specific tab: Oscilloscope test record

Oscilloscope record toolbar

2

Information and user note

3

Overview and trace navigation screen

4

Zoom in view and trace navigation

5

Oscilloscope toolbar

2016-03

1
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8.13.4

Toolbars and Shortcuts
Note!
If you close the oscilloscope dialog, all unsaved recordings are lost.
Oscilloscope Record Toolbar
Icon

Name

Action

Save

Save oscilloscope record to database.

Export options

In the submenu that opens, choose from the
following export options:
1. Export to a file.
File type: XML
2. Export as an image.
File types: png, jpeg, gif, bmp
Copy the current oscilloscope record to the
clipboard.

Page setup

Change the following page setup attributes:
Paper size, left margin, bottom margin, etc.

Print

Print the current view of the oscilloscope
record.

Close

Close the current oscilloscope record.

2016-03

Copy
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Oscilloscope Toolbar
Name

Action

Move

Grab and move the
Press and hold the left
graph. Press and hold mouse button.
the left mouse button.

Horizontal marker

Measure the voltage
difference.

Press left mouse
button to set the first
marker and press the
right mouse button to
set the last marker.

Vertical marker

Measure the time
difference.

Press the left mouse
button to set the upper
marker and press the
right mouse button to
set the lower marker.

Rectangular marker

Measure time and
voltage difference.

Press and hold the left
mouse button to set
the rectangular
marker.

Marker measurement

Measure the time and Click a point of the
voltage at one point. graph to read the
values.

Zoom in

Enlarge the view of
the graph.

Click the graph.

Scale 1:1

See 1:1 graph size.

Click the graph.

Zoom out

Reduce the view of
the graph.

Click the graph.

Show/Hide
information

Show or hide the
oscilloscope record
information section.

Click the icon to show
or hide the
information.

Communication
details

Show communication Click the icon to show
layer 2 details.
the information.

Analysis

Show/hide layer 2
details.
■ Layer 1 Bit level
■

Layer 1 Sections

■

Layer 2 Short

■

Layer 2

■

Layer 1 Physical
Measurements

Handling

Click the icon and
select which details to
show or hide.

2016-03
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8.14

FDH–1 Device-Specific Tab > All Functions
Use the All Functions… pulldown menu as a direct access point for all measuring,
parameterization, or configuration activities:
■

Online measurement: Remote access to live FDH–1 diagnostic measurements via FDH–1
Manager

■

Segment database: Editing the segment record

■

Fieldbus communication: Enable/disable communication, default address change, and
communication settings

■

FDH–1: Adjusting device-related settings: Upload/download of segment records, edit the
tag, update firmware/language, view license information

All Functions ... pulldown menu.

2016-03

Figure 8.29
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8.14.1

Select Segment Record
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Select segment record

Selecting a Segment Record
For information on segment records and the different types of records to choose from, see
chapter 7.2.
In order to select a segment record, go to All Functions… > Select segment record.
The following menu appears:

FDH-1 Manager: Select segment record dialog

2016-03

Figure 8.30
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8.14.2

Commission Segment
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Commission segment

Commissioning a Segment
For detailed information on segment commissioning, see chapter 7.3.
1. In order to commission a segment, go to All Functions… > Commission segment .
The following wizard opens:

Figure 8.31

FDH–1 Manager: Commissioning wizard start page

2. In order to select a specific segment, click the button Select segment record...

2016-03

The following selection menu appears:
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Figure 8.32

FDH-1 Manager: Select segment record dialog

3. Select a segment and confirm with OK.
4. Use the settings section to determine the information depth that the commissioning wizard
retrieves:
- Create oscilloscope recordings for all devices
- Read device info
For information on these options, see chapter 7.3.
5. Use the information of this wizard to check the previously set parameters or change them. 
For details on editing the topology, see chapter 8.6.1.
6. In the topology settings section, select between the following settings:
- Ignore topology settings for diagnostic calculation
- Use the following segment topology settings. 
For detailed information on adjusting the topology settings, see chapter 8.6.1.
7. Click Next to continue.
If you activated the "Read device info" setting, you are asked to enable fieldbus
communication for this task:

2016-03

Figure 8.33

FDH–1 Manager: Enable fieldbus communication dialog

8. Confirm the message to continue.
The wizard scans the segment for existing field devices.
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Figure 8.34

FDH–1 Manager: Commissioning wizard scanning devices

9. Click Next to continue.

2016-03

You see the diagnostic data overview. Check the information displayed here for
inconsistencies. If you find any problems, leave the commissioning wizard and resolve them
first.
For more information, see "Viewing Measurement Data in FDH-1 Manager" on page 81.
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Figure 8.35

FDH–1 Manager: Commissioning wizard diagnostic data overview, overview tab

10.In order to view detailed measurement data, click the Segment Measurements tab.

2016-03

You see the diagnostic data overview for the segment measurements. Check the
information displayed here for inconsistencies. If you find any problems, leave the
commissioning wizard and resolve them first.
For more information, see "Viewing Measurement Data in FDH-1 Manager" on page 81.
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Figure 8.36

FDH–1 Manager: Commissioning wizard diagnostic data overview, segment
measurements tab

11.In order to view detailed measurement data, click the Device Signal Level tab.

2016-03

You see the diagnostic data overview for the device signal level. Check the information
displayed here for inconsistencies. If you find any problems, leave the commissioning
wizard and resolve them first.
For more information, see "Viewing Measurement Data in FDH-1 Manager" on page 81.
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Figure 8.37

FDH–1 Manager: Commissioning wizard diagnostic data overview, device signal
level tab

12.Click Next to continue.

2016-03

The recording of the test record starts.
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Figure 8.38

FDH–1 Manager: Commissioning wizard recording test record

2016-03

13.When the recording is complete, the following window appears:
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Figure 8.39

FDH–1 Manager: Commissioning wizard, commissioning test record result

The commissioning result dialog shows a list of diagnostic messages for the segment that was
tested.
■

Next: Ignore the messages and complete the commissioning.

■

Back: Go back and check the settings.

14.Click Next to continue the commissioning.

2016-03

If the commissioning process was completed successfully, a success message appears:
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Figure 8.40

FDH–1 Manager: Commissioning wizard summary

15.In order to leave the wizard, click Close.

2016-03

FDH-1 Manager opens a new tab with the commissioning report:
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Figure 8.41

FDH–1 Manager: Commissioning report

Note!
Measuring at the Spurs of Short-Circuit Proof Device Couplers

2016-03

For information on impedance deviation when measuring at the spurs of short-circuit proof
device couplers, see chapter 3.6.
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8.14.3

Check Segment
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Check segment

Checking a Segment
For details on the check segment function, see chapter 7.4.
1. In order to check a segment, go to All Functions… > Check segment .
The following wizard opens:

Figure 8.42

FDH–1 Manager: Check segment wizard settings

Settings for the check segment wizard:
■

Create oscilloscope recordings for all devices

■

Read device info

For details on these options, see chapter 7.4.
2. Click Next to continue.

Figure 8.43
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You are asked to enable fieldbus communication for this task:
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3. Confirm the message to continue.
The wizard records the check segment test record.

Figure 8.44

FDH–1 Manager: Check segment wizard recording check segment test record

2016-03

4. When the recording is complete, you can optionally add a report description:
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Figure 8.45

FDH–1 Manager: Check segment wizard report description option

5. Click Next to continue.

Figure 8.46
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FDH–1 Manager: Check segment wizard summary

2016-03

If the segment check was completed successfully, a success message appears:
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6. In order to leave the wizard, click Close.
FDH-1 Manager opens a new tab with the check segment report:

FDH–1 Manager: Check segment report

2016-03

Figure 8.47
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8.14.4

Test Failure Margin Function
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Test failure margin

Testing the Failure Margin of a Segment
For detailed information on this function, see chapter 7.5.3.
1. In order to test the failure margin of a segment, go to All Functions… > Test failure margin.
The following selection menu appears:

Figure 8.48

FDH–1 Manager: Test failure margin wizard settings

2. In order to select a specific segment, click the button Select segment record.

2016-03

The following selection menu appears:
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Figure 8.49

FDH-1 Manager: Select segment record dialog

3. Select a segment and confirm with OK.
4. Determine whether you would like to insert noise into the segment for this test.
If you activate this option, the following message is displayed:

Figure 8.50

FDH-1 Manager noise injection warning message

5. NOTE: Injecting noise into the segment disrupts communication during the time the
segment is tested. Noise is injected into the segment at 2 different frequencies: 31.25 kHz
or 125 kHz. 
Voltage levels range from 20 mV … 120 mV.
In order to determine the sensitivity of the segment to noise reliably, this test takes up to
approx. 10 min.

2016-03

6. You are asked to enable fieldbus communication for this task. Click Yes to continue.
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Figure 8.51

FDH–1 Manager: Enable fieldbus communication dialog

The wizard scans the segment for the devices.

Figure 8.52

FDH–1 Manager: Failure margin test wizard scanning devices

7. Click Next to start the test.
8. Click Next to continue.

2016-03

The wizard first records the condition of the physical layer:
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Figure 8.53

FDH–1 Manager: Failure margin test wizard recording physical layer data

2016-03

9. Next, the wizard executes the failure margin test.

Figure 8.54

FDH–1 Manager: Failure margin test wizard failure margin test
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10.If the test was completed successfully, a success message appears:

Figure 8.55

FDH–1 Manager: Failure margin test wizard summary

11.In order to leave the wizard, click Close.
FDH-1 Manager opens a new tab with the failure margin test report:

FDH–1 Manager: Failure margin test report

2016-03

Figure 8.56
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8.14.5

Edit Segment Record Function
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Edit segment record

Editing the Segment Record
In order to edit a segment record, go to All Functions… > Edit segment record. For details
see chapter 8.6.

8.14.6

Go To Segment Record Function
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Go to segment record

Going to a Segment Record
In order to go to a segment record, go to All Functions… > Go to segment record. This takes
you to the Segment database tab:

FDH–1 Manager: Segment database tab

2016-03

Figure 8.57
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8.14.7

Fieldbus Communication
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Fieldbus
communication (enable/disable)

De-/Activating Fieldbus Communication
In order to enable or disable fieldbus communication, go to All Functions… > Enable/disable
fieldbus communication.
Communication is required to read the device info.
Enabling Communication
You are asked to enable fieldbus communication:

Figure 8.58

FDH–1 Manager: Enable fieldbus communication dialog

Confirm with Yes.
In the "All Functions…" pulldown menu, the function Enable/disable fieldbus
communication is preceded by a check mark to indicate that the function is activated:

Disabling Communication
In order to disable fieldbus communication again, click All Functions… > Enable/disable
fieldbus communication.

2016-03

The check mark disappears.
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8.14.8

Changing Communication Settings
Navigation: FDH–1 Device-Specific tab > All Functions... pulldown, section Fieldbus
Communication.

FOUNDATION Fieldbus: Changing Default Addresses
Prerequisite: Define the lowest address in the "Auto address start" function.

Figure 8.59

FDH-1All Functions ... pulldown menu: Auto address start
Auto address start: Defines the lowest address that FDH-1 can use to assign addresses to devices using a default
address.

In order to change the default addresses, go to All Functions… > Change default addresses
(enable/disable).
Change the default address to assign a device with a default address to a permanent address.
Starting with the lowest address defined in auto address start function, FDH–1 changes default
addresses to permanent addresses. This function can only be used if no additional LAS is
connected to the segment. If the device does not contain a tag description, FDH-1 assigns a
physical tag description in order to change the default address.

PROFIBUS PA: Changing the Communication Settings
In order to change the communication settings for a PROFIBUS PA fieldbus, go to All
Functions… > Fieldbus Communication Settings.

Figure 8.60

FDH-1All Functions ... pulldown menu: Communication settings

Retries: Set the maximum number of retries FDH-1 uses.

■

Master address: Define the address FDH-1 uses when in fieldbus master mode.

2016-03

■

127

Fieldbus Diagnostic Handheld
FDH-1 Manager Software

8.14.9

Upload Test Records
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Upload test records...

Uploading Test Records
Note!
When connecting the handheld to the PC after completing test recordings, FDH–1 Manager
automatically detects that new records are available for upload.
1. In order to upload device-related data, switch to the FDH–1 device tab.
The following message appears:

Figure 8.61

FDH–1 Manager: Upload test records dialog

■

Yes: Starts the upload process.

■

No: Cancels the upload process.

2. In order to upload the new records, confirm with Yes.

Figure 8.62
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FDH-1 Manager Device-specific tab: Go to All Functions ... and select Upload
test records.

2016-03

3. Alternatively, you can upload test records any time by using the upload function. Go to All
Functions… > Upload test records.
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4. If the Start upload… option appears in the closely related tasks section in the upper right
corner of the window, you can choose this option instead.

Figure 8.63

FDH–1 Manager Functions section: Related tasks, Start upload...

The upload dialog appears:

Figure 8.64

Dialog
Functions

FDH–1 Manager: Upload test records dialog

Description

Handling

2016-03

Open the plant topology and
Click to open the topology dialog.
determine the location the test
record is to be saved to.
If you do not determine the target
directory, the records are uploaded
to the unspecific, customized or
specific segment folders, depending
on the types of records.
Button activated (default): Marks
record to be uploaded. 
Item is automatically deleted from
the handheld after upload.

In order to deactivate, click button.

Button deactivated (default):
Deletion option not active.

In order to activate, click button.
The record on the handheld is
marked for deletion.
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5. If the upload was successful, FDH–1 Manager displays a confirmation message:

FDH–1 Manager: Upload test record, summary

2016-03

Figure 8.65
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8.14.10

Download Segment Records
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Download segment
records...

Downloading Segment Records
In order to download segment records, go to All Functions… > Download segment record.
For details see "Downloading Segment Records" on page 131.

Downloading Segment Records
1. In order to download segment records, switch to the FDH–1 device tab.
2. In the All Functions … pulldown menu, select Download Segment records…

Figure 8.66

FDH-1 Manager Device-specific tab: Go to All Functions ... and select Download
segment records.

3. Alternatively, if offered as a closely related task, select Download segment records…
directly from the related tasks section:

Figure 8.67

FDH–1 Manager Functions section: Related tasks, Download segment records...

2016-03

This opens the download dialog.
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Figure 8.68

FDH–1 Manager: Download segment records dialog

■

Remove all segment records: Removes all segment records

■

Remove all unknown segment records: Removes all segments that cannot be
assigned to any existing segment

■

Right-hand pulldown arrow: Status information that shows the total number of slots
available on the device and the number of slots that are still free.

2016-03

4. Use the download dialog to select the segment records to be downloaded to or deleted
from the handheld.
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Adding Segment Records onto the Handheld
1. From the segment database dialog section, browse the plant structure and click the segment
records to be added to the list for downloaded onto the handheld.

Figure 8.69

FDH-1 Manager: Download segment records, options for adding

Tag

Database path

Record added from the
database, not on handheld

Segment path in database

Status
: Record
added

Action
: Undo "Add
record"

2. Add one or more segment records or the contents of whole folders with drag and drop to the
selection.
The selected items are added to the device segments list.

2016-03

3. If needed, repeat this procedure for up to as many segment slots as are free on the device.
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Deleting Segment Records from the Handheld
1. If the segment management menu already contains segment records, it appears as follows:

Figure 8.70

FDH-1 Manager: Download segment records, options for deleting

Tag

Database path

Record on handheld and in
database, not modified

Segment path in database

Record on handheld and in
database, modified

Segment path in database

Record on handheld

{not contained in database}

Record on handheld and
marked for deletion.
Information struck out.

Path shown before deletion
Information struck out.

Status

Action
: Delete
record

: Record
modified
: Unkown
status
:
Marked for
deletion

: Delete
record
: Delete
record
: Undo
"Delete
record"

2. In order to delete a segment record from the handheld, click the Delete button.
The following result appears:

Dialog Information

Description

3. If needed, you can undo the deletion by selecting the Undo Delete button.

134

2016-03

Status information: Segment record is deleted. Also, the segment
record to be deleted is struck out.
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4. When finished, select Start.
The segment records are deleted from the handheld.
5. Once you are finished with the segment management activities, click Close.
Restart brings you back to the segment management menu.

8.14.11

Edit FDH-1 Tag
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Edit FDH-1 Tag...

Editing FDH–1 Tag
In order to edit the FDH–1 tag, go to All Functions… > Edit FDH–1 tag. The following dialog
appears:

Figure 8.71

FDH-1 Manager: Tag dialog

2016-03

Change the tag as needed and confirm with OK.
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8.14.12

Update Firmware/Language
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Update
firmware/language...

Updating the Firmware
Before you perform a firmware update, make sure that the handheld is connected to the PC.
1. In order to update the firmware of FDH–1 or add a language, go to All Functions… > Update firmware.
The following wizard opens:

Figure 8.72

FDH–1 Manager: Firmware update wizard

1

In order to read the current firmware information of FDH-1, select Check device.

2

For the update, select whether to use the firmware included in FDH-1 Manager or firmware stored on a disk.

3

Select the firmware language.

4

Click Next.

2016-03

2. The wizard now downloads the firmware onto the connected handheld:
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Figure 8.73

FDH–1 Manager: Firmware update wizard updating firmware

3. If the update was successful, the following success message appears:

FDH–1 Manager: Firmware update wizard summary
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Figure 8.74
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8.14.13

Licensing
Navigation: FDH–1 Device-Specific tab > All Functions pulldown > Licensing ...

Licensing
The licensing function is used to enter license information.
In order to activate the premium functions of FDH–1 Manager, enter the product license key.
You find the 18-digit number on your license certificate.

Activating or Adding a License Key
1. In order to add license information, go to All Functions… > License.
The following dialog opens:

Figure 8.75

FDH–1 Manager licensing dialog

■

Add license key: Adds a license key in order to activate the premium functions of FDH–1
Manager

■

Associate license to connected FDH–1: Connects the license details you have entered
with the FDH–1 actually connected to the PC

■

List of licensed devices: List of FDH–1s and associated licenses that already have
been connected to the PC

2. In order to add a license key for FDH–1 Manager: Click the button Add license key ...

2016-03

If you use a Microsoft Windows 7 or later edition, Windows asks you if you allow the
program to make changes to the PC. Accept to continue. 
The following dialog appears:
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Figure 8.76

FDH–1 Manager: License activation tool

3. Enter the 18-digit number and confirm with Activate.
If the license key entered is correct, the following confirmation message appears:

Figure 8.77

FDH–1 Manager license activation success message

4. In order to associate a license to a connected FDH–1: Click the button Associate license
to connected FDH–1...
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The license is associated to the handheld that is connected to the PC. If the handheld is
already associated or if no more licenses are available, an error message appears:
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FDH–1 Manager license association error

2016-03

Figure 8.78
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